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About This Guide

This guide is written to provide administrators the conceptual and procedural information for using the
Cross-Empire Data Migration subsystems of Micro Focus File Dynamics.

+ Chapter 1, “Performing an eDirectory to Active Directory Cross-Empire Data Migration,” on
page 7

+ Chapter 2, “Performing an Active Directory to Active Directory Cross-Empire Data Migration,” on
page 95

Audience

This guide is intended for network administrators who are tasked with migrating network user and
group folders, permissions, and metadata from:

+ eDirectory to Active Directory
+ Active Directory to Active Directory

Feedback

We want to hear your comments and suggestions about this guide and the other documentation
included with this product. Please use the User Comment feature at the bottom of each page of the
online documentation, or go to www.novell.com/documentation/feedback.html and enter your
comments there.

Documentation Updates

For the most recent version of the Micro Focus File Dynamics 6.5 Cross-Empire Data Migration
Guide, visit the Micro Focus File Dynamics Documentation website (https://www.novell.com/
documentation/file-dynamics-60/).

Additional Documentation

For additional Micro Focus File Dynamics documentation, see the following guides at the Micro Focus
File Dynamics Documentation website (https://www.novell.com/documentation/file-dynamics-60/):

+ Micro Focus File Dynamics 6.5 Installation Guide
+ Micro Focus File Dynamics 6.5 Administration Guide
+ Micro Focus File Dynamics 6.5 Data Owner Client Guide
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1.1

Performing an eDirectory to Active
Directory Cross-Empire Data Migration

eDirectory to Active Directory Cross-Empire Data Migration is a for-purchase add-on subsystem for
File Dynamics that allows for the movement of file system data from the Novell or Micro Focus NSS
network file system and eDirectory directory service, to the Microsoft NTFS network file system and
Active Directory directory service.

Many customer initiatives can precipitate the need for such a move, including a migration to a
different server operating system, a merger and acquisition by the organization, or just the
consolidation of environments.

+ Section 1.1, “Understanding an eDirectory to Active Directory Cross-Empire Data Migration,” on
page 7

¢ Section 1.2, “Security and Ownership,” on page 10

+ Section 1.3, “Prerequisites,” on page 11

+ Section 1.4, “Creating the Migration Proxy Account,” on page 13

+ Section 1.5, “Creating and Modifying an Identity Map,” on page 15

+ Section 1.6, “Migration Options,” on page 33

+ Section 1.7, “Viewing the Migration Log File,” on page 34

+ Section 1.8, “Performing a User to User Data Migration,” on page 35

+ Section 1.9, “Performing a Folder to User Data Migration,” on page 42

¢ Section 1.10, “Performing a Group to Group Data Migration,” on page 50

¢ Section 1.11, “Performing a Folder to Group Migration,” on page 58

+ Section 1.12, “Performing a Folder to Folder Migration,” on page 65

Understanding an eDirectory to Active Directory
Cross-Empire Data Migration

The mission of Cross-Empire Data Migration is to quickly and easily perform automated movement of
data, based on a variety of scenarios, including the movement of data for multiple users and groups
directly to its intended location across multiple servers or shares in a single operation, all while
preserving certain file system metadata. Further, Cross-Empire Data Migration lets you leverage the
policies provided in File Dynamics to allow you to move to a managed storage environment on the
target system and optionally restructure and reorganize data in the process.

A wizard in the Admin Client allows you to implement a phased approach to migration by
incorporating one or more migration types offered through the interface to add work onto the File
Dynamics event queue. In taking advantage of the dispatching and state machine architecture
features of the event queue, the migration effort can be enhanced both in terms of performance
through the Agent subsystem and in terms of reliability in overcoming outages and other factors that
occur in real-world environments. Additionally, other options involving copying permissions, file
ownership, filtering of the files to be copied and more, allow for greater control and flexibility during a
data migration operation.

Performing an eDirectory to Active Directory Cross-Empire Data Migration
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In addition to the eDirectory to Active Directory Cross-Empire Data Migration, there is a separate for-
purchase Active Directory to Active Directory Cross-Empire Data Migration offering. For more
information, see Chapter 2, “Performing an Active Directory to Active Directory Cross-Empire Data
Migration,” on page 95.

The eDirectory to Active Directory Cross-Empire Data Migration generally supports three constructs
for movement:

+ Section 1.1.1, “User Storage Migration,” on page 8
+ Section 1.1.2, “Collaborative or Group Storage Migration,” on page 9
+ Section 1.1.3, “Direct Folder Storage Migration,” on page 9

1.1.1 User Storage Migration

Cross-Empire Data Migration can be used to copy User object personal file data from the source
platform to the target platform. In an eDirectory to Active Directory scenario, this would likely be a
migration of the data from the Novell or Micro Focus home directory to the Microsoft home folder.
There are two options for migrating personal storage. The difference between the two is related to
how File Dynamics determines the path to a specific user’s data on the source network. These
options can be used exclusively or in combination with one another during a migration project:

¢ “User to User” on page 8

+ “Folder to User” on page 8

User to User

This option allows you to instruct File Dynamics to determine the source location for user data by
using the Home Directory attribute in eDirectory. As part of the migration wizard, you specify a source
eDirectory container. The User objects within that container are listed for matching with the target,
and you can select one or more users for migration. For each user selected, the Home Directory
attribute provides the source file system path to be used. This option is very useful when the Home
Directory attribute in the source tree is populated correctly and there is a need to migrate data
simultaneously from multiple locations on the source network. It is also very useful if the user
directory name on the source does not match the account name on the target.

For procedures on performing a user to user data migration, see Section 1.8, “Performing a User to
User Data Migration,” on page 35.

Folder to User

This option allows you to specify the location of user data by providing a file system path as the
source. Instead of specifying an eDirectory container, you specify a parent folder location on the file
system in the source network. From this folder, all immediate subfolders are listed for matching with
the target, and you can select one or more for migration. This option is useful when the Home
Directory attribute in the source tree is not populated or reliable, or there is a need to migrate a set of
users with folders in a single path on a single volume.

For procedures on performing a folder to user data migration, see Section 1.9, “Performing a Folder
to User Data Migration,” on page 42.
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1.1.2

11.3

Collaborative or Group Storage Migration

File system data used by groups can also be copied by using the eDirectory to Active Directory
Cross-Empire Data Migration subsystem. The options available to the administrator are similar to
those available for user storage, but are different in whether to rely on data in directory services or
specify the file system paths directly.

The underlying concept behind both options is that the collaborative storage is being moved to a
managed storage environment on the target network, which means that the collaborative managed
path attribute is being populated and managed in directory services in the target. If you don’t want to
move some of the collaborative group directories, you should consider using direct folder storage
migration., which is documented at Section 1.1.3, “Direct Folder Storage Migration,” on page 9.

The following options are available for moving collaborative storage:

+ “Group to Group” on page 9
+ “Folder to Group” on page 9

Group to Group

This option allows you to instruct File Dynamics to determine the source location for user data by
using the group managed path attribute in eDirectory. As part of the migration wizard, you specify a
source eDirectory container. The Group objects within that container are listed for matching with the
target, and you can select one or more groups for migration. For each group selected, the group
managed path attribute provides the source file system path to be used. This option is very useful
when File Dynamics has been used to manage collaborative storage in the source tree.

For procedures on performing a group to group data migration, see Section 1.10, “Performing a
Group to Group Data Migration,” on page 50.

Folder to Group

This option allows you to specify the location of group data by providing a file system path. Instead of
specifying an eDirectory container, you specify a parent folder location on the file system in the
source network. From this folder, all immediate subfolders are listed for matching with the target, and
you can select one or more for migration. This option is useful when File Dynamics has not been used
in the source tree to manage collaborative group storage or when you are migrating only some of the
group storage.

For procedures on performing a folder to group data migration, see Section 1.11, “Performing a
Folder to Group Migration,” on page 58.

Direct Folder Storage Migration

A major benefit in using File Dynamics is that your organization can move to a managed storage
environment for its file system data. File Dynamics allows you to define and enforce policies on the
data by driving management of it throughout the life cycle of the user or group associated with the
data. The architecture of the Cross-Empire Data Migration subsystem allows organizations to move
to this paradigm for both user and group storage.

However, you are not required to use this method during the migration process. You might not want to
move to managed storage for all of the data, or you might want to move to it in phases. For this
reason, the Cross-Empire Data Migration subsystem has provisions for direct movement of data
outside of the policy construct by performing a folder to folder data migration.

Performing an eDirectory to Active Directory Cross-Empire Data Migration
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1.21

Folder to Folder

A folder to folder migration allows you to move a folder and its contents directly from the source
network to a designated location on the target network. Selecting this method in the wizard allows you
to specify distinct file system paths on both the source and the target networks. All file system
contents and metadata are copied during the operation.

For your convenience, there is a Skip Open Files option that will migrate all unopened files located in
a folder. Open files are not migrated, but the filenames and paths of all of the open files are logged in
a delta file. You can then ensure that all open files are closed and do a follow-up migration of these
remaining files by simply specifying the location of the delta file.

You can identify and move all files that are new or have been modified from a given date. Additionally,
you can verify that all of the files you wanted to migrate from a source server have been migrated.

Following the folder to folder migration, use the CEDMScanCompare utility to scan the NetWare or
Open Enterprise Server source for all new and modified folders and files. Once these new folders and
files have been migrated, use CEDMScanCompare again to generate a folder and file content list for
both the source server and the target server, then use the application to compare the two lists to
verify that all folders and files migrated properly.

For procedures on performing a folder to folder migration, see Section 1.12, “Performing a Folder to
Folder Migration,” on page 65

Security and Ownership

Moving to a managed storage environment presents an opportunity to refine the security on the data
itself. By defining the security that should be on the file system as a part of the policy, you are assured
that the security of the data on the target network is in line with the security and governance
requirements that your organization wants to employ. This can also contribute to present and future
compliance requirements for your organization. Avoiding these types of exposure is another benefit of
moving to a managed storage environment.

However, in many environments, there is a desire to migrate security and ownership assignments
directly from the source environment to the target. This capability is accomplished through the
creation and optional usage of an Identity Map as a part of a migration operation.
+ Section 1.2.1, “Defining an Identity Map for Security and Ownership Migration,” on page 10
¢ Section 1.2.2, “Using an Identity Map,” on page 11

Defining an Identity Map for Security and Ownership
Migration

For security and ownership information to be migrated between environments, the Cross-Empire
Data Migration subsystem requires a series of object equivalence definitions to identify an object in
the source environment as equivalent to an analogous object in the target environment. In other
words, if an object in the source environment is given rights to a file or folder, and you want that

Performing an eDirectory to Active Directory Cross-Empire Data Migration
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trustee assignment to be migrated along with the data, then File Dynamics must be told which object
in the target environment is equivalent to it so that the appropriate rights assignment can be made. An
identity map is a construct for creating and managing these equivalence definitions.

You can create and populate an identity map within the Cross-Empire Data Migration subsystem of
the Admin Client interface. There are various options for automatically locating and matching objects
based on a number of matching rules. There are options for creating manual assignments as well as
for editing assignments.

However, some objects that are assigned rights in the source environment might not have an
analogous object that already exists in the target environment. These objects need to be created
before they can be defined to an identity map.

In addition, an analogous object might exist in the target environment, but might not be able to be
assigned as a trustee, such as a container that is given rights in the source environment. The same
container might exist in the target environment (Active Directory), but Active Directory does not
support the assignment of a container as a security object. In these instances, a group representing
the container is usually created for assigning permissions.

You can import data into an identity map. This can be useful when you already have a data set
defining equivalences, or you can easily create one using data from an external system.

In general, it is standard practice to iteratively evolve an identity map as needed to perform a
migration. Within the interface, you can run a check scan against a given source file system path to
check rights and ownership assignments against an identity map. This identifies which objects still
need a definition within the map in order for a migration to finish with 100 percent coverage for
security and ownership.

Using an Identity Map

When you are satisfied with the coverage within the identity map for a given file system path, you can
use the identity map as a part of a migration. You can optionally use the identity map in conjunction
with any migration operation type supported by the Cross-Empire Data Migration subsystem:

+ User storage migration

+ Collaborative or group storage migration

+ Direct folder storage migration
The system supports a single identity map within the framework at any one time. When the map is

created or edited, the master copy is held by the Engine and is automatically distributed to Agents as
necessary.

IMPORTANT: Certain operations during a Cross-Empire Data Migration involve building a cache on
the local workstation or the Engine. If the identity map contains more than 20,000 objects, the time it
takes to cache all of the objects could significantly inhibit the speed of the migration.

Once the cache has been built the first time on the workstation or Engine, it does not have to be
rebuilt again.

Prerequisites

The server on which the Engine in Active Directory is installed must have the Client for OES installed
while the migration is being performed. After the migration is complete, the client can be removed.
Additionally, the Engine can delegate migration operations to Agents for improved migration

Performing an eDirectory to Active Directory Cross-Empire Data Migration 1



performance. If Agents are deployed as a part of a File Dynamics installation, these Agents are
individually used for migration if the Client for OES is installed on them. In order for an Agent to
participate in a migration, the server that has the Agent installed must also have the Client for OES
installed. This determination is made automatically within File Dynamics as a part of Agent/Engine
communications and no additional configuration is required in order to use this feature.

The Client for OES installed on the Engine in Active Directory should be properly configured to use
SLP (Service Location Protocol) for the eDirectory tree source of a data migration. For information on
SLP configuration, see “Setting Client Properties” (https://www.novell.com/documentation/
windows_client/windows_client_admin/data/hbgx7szx.html) in the Client for Open Enterprise Server
Administration Guide.

1.3.1 Prerequisite Tasks

Before you proceed with an eDirectory to Active Directory Cross-Empire Data Migration, perform the
following tasks:
1. Log in with Administrative access to the domain.
2. Install the File Dynamics Engine on the target Windows server.
See “Installing the Engine” in the Micro Focus File Dynamics 6.5 Installation Guide.
3. Install the Client for OES with the NMAS installation default option on the Engine server.
The Client for OES can be removed after you have completed your migrations.
4. Extend the Active Directory schema.
This is required only if you are migrating to a target share managed by a collaborative storage
policy.
See “Active Directory Schema” in the Micro Focus File Dynamics 6.5 Installation Guide.
5. Install the Admin Client.
See “Installing the Admin Client” in the Micro Focus File Dynamics 6.5 Installation Guide.
6. (Optional) Install and authorize the Event Monitor.

The Event Monitor is not needed for a Cross-Empire Data Migration, but is needed for managing
storage once your data has been migrated to the Microsoft network.

See “Installing and Configuring the Event Monitor” and “Authorizing the Event Monitor” in the
Micro Focus File Dynamics 6.5 Installation Guide.

7. Assign SMProxyRights group Full Control permission to the shares to which you will be
migrating data.

See “Setting Rights and Privileges on Managed Storage” in the Micro Focus File Dynamics 6.5
Installation Guide.

8. Install and authorize Agents and configure Proxy Agents for all servers that will be target servers
for Cross-Empire Data Migrations.

See “Installing and Configuring the File System Agents” and “Authorizing the Agents ” in the
Micro Focus File Dynamics 6.5 Installation Guide.

9. (Conditional) If you plan to migrate data to a NAS device, make the fdproxyrights group a
member of the Local Administrators group on each NAS device.

See “Setting Rights and Privileges on Managed Storage” in the Micro Focus File Dynamics 6.5
Installation Guide.

10. Install the Client for OES and configure SLP on any Agent servers that will be involved in a
Cross-Empire Data Migration.

The Client for OES can be removed after you have completed your migrations.

12 Performing an eDirectory to Active Directory Cross-Empire Data Migration
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11. Create File Dynamics policies for the migration of storage.

These policies are needed if the Cross-Empire Data Migrations will be driven by File Dynamics
policies, which we recommend for migrating user data.

12. For all objects in eDirectory that have rights assigned to the file system, create matching objects
in Active Directory.

To migrate rights assigned to containers, you must create an equivalent Group object in Active
Directory for each container object in eDirectory.

Creating the Migration Proxy Account

The Engine running in Active Directory uses a migration proxy account to log in to the eDirectory tree.
Any time you perform a migration from the eDirectory tree to the Active Directory domain, the Admin
Client uses the migration proxy account that you establish in this procedure.

IMPORTANT: This process creates a new User object in eDirectory with a 32-character password
that is generated automatically by File Dynamics. If your Universal Password policy does not
accommodate 32-character passwords, you must modify or create a new Universal Password policy
before proceeding. For more information, refer to Section 3.4, “Creating Password Policies,” (http://
www.novell.com/documentation/password_management33/pwm_administration/data/an4bun5.html)
in the Novell Password Management 3.3.1 Administration Guide, especially the information in Figure
3.3, “Advanced Password Rules Continued.”

1 Launch the Admin Client.
2 From the Cross-Empire Data Migration tab, click eDirectory to Active Directory.

3 From the Proxy Account Management drop-down menu, select Provision Source Proxy
Account.

Performing an eDirectory to Active Directory Cross-Empire Data Migration 13
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Provision Migration Source Proxy Account

Default Source Server Address
Enter the IP address or DNS name of the default eDirectory server in the source

tree.

Migration Proxy Account
Enter the name of the Migration Proxy account to create in the source tree. The
account may be entered as a typeful or typeless FDM such as admin.org or
crn=admin.org.
This account will be created as a user object, and will be granted full Supervisor
access to the root of the source eDirectory tree.

Admin Name
Enter the name of an administrator account in the source tree. The account may be
entered as a typeful ortypeless FDN such as admin.org or cn=admin.o=org.

Password
Enter the password for the admin account.

Default Server Address
o Enter Migration Proxy Account and Admin Mame as dotted FDMs

Migration Proxy Account
Admin Mame

Password

Cancel

4 Fill in the following fields:

Default Server Address: Specify the IP address or DNS name of a server in the eDirectory tree
where the files you want to migrate are located. The Engine in the Active Directory environment
must be able to communicate with this server when performing data migrations.

Migration Proxy Account: Provision a migration proxy account by specifying the typeless fully
distinguished name (FDN) of the proxy account that you want to provision.

The Engine running in Active Directory uses the migration proxy account to log in to the
eDirectory tree. Any time you perform a migration from the eDirectory tree to the Active Directory
domain, the Engine uses the migration proxy account that you establish in this step.

Admin Name: Specify the typeless FDN of an account in the source eDirectory tree that has the
appropriate right to provision the Migration Proxy Account (MPA).

Password: Specify the password for the typeless FDN provided above.
5 Click OK
6 When the confirmation dialog box appears, click Yes.

14 Performing an eDirectory to Active Directory Cross-Empire Data Migration



The information entered in the Provision Migration Source Proxy Account dialog box is now
displayed in the fields of the Migration Source Information region of the page.

The Engine logs in as the Admin account provided and provisions the MPA as a User object in
the source eDirectory tree. It also grants the MPA object full rights to the root of the source tree,
which allows File Dynamics to pull eDirectory and file system information during the course of
migration operations.

1.5 Creating and Modifying an Identity Map

The eDirectory to Active Directory Cross-Empire Data Migration uses an identity map to make
associations between the users, groups, and containers that are the owners and trustees of the
Novell or Micro Focus network data and the corresponding data owners on the Microsoft network
target.

You create a single identity map for each eDirectory tree that you are migrating.

IMPORTANT: You must create an identity map so that file and folder rights, trustee assignments, and
other metadata are maintained during the migration. If you do not want to maintain these rights,
trustee assignments, and other metadata, you can skip this section and migrate through using the
Data Only option from the Migration Wizards menu.

+ Section 1.5.1, “Creating an Identity Map,” on page 15

+ Section 1.5.2, “Importing a Source Path List,” on page 24

¢ Section 1.5.3, “Adding Source Entries to the Identity Map,” on page 25

+ Section 1.5.4, “Adding or Modifying Target Entries to the ldentity Map,” on page 26
+ Section 1.5.5, “Saving a Local Instance of the Identity Map,” on page 28

+ Section 1.5.6, “Loading a Saved Identity Map,” on page 28

+ Section 1.5.7, “Generating a Migration Preview Report,” on page 28

+ Section 1.5.8, “Adding Entries from Preview Reports,” on page 31

+ Section 1.5.9, “Review Rights and Trustee Assignment Mappings,” on page 32

1.5.1 Creating an ldentity Map

1 In the Admin Client, click the Cross-Empire Data Migration tab.
2 Click eDirectory to Active Directory.
3 Click Identity Map Management > Edit Identity Map.

The following page appears:
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Identity Map = a X

/ Identity Map Entry Wizard & Manage Map Entries ~ Lp Source Paths - El Load ~ E Save o Reload G Refresh

Source FDN Target FDN Target SAM Account Browse Target | SearchTarget | Well-known SIDs
[Public] Everyone BUILTIM\Everyone e
[Supervisor] Local System BUILTIM\Local System UReﬂESh
« A\ dynamics.cctecorg
» 'Fg Builtin
» 'Fg Computers
» To Domain Controllers
» Tg DYMaMICS
» 'Eg ForeignSecurityPrincipals
» 'Fg Keys
» To Managed Serice Accounts
» Tg Program Data
» 'Eg Service Accounts
» 'Fg System
» T Users
FDN [Publig] FDMN Everyone =
Type Index (21) Pseudo Security Principal Type Index (2) Group
Class Mame | ccc-PseudoSecurityPrincipal Class Name | Built-In
GuUID {701ESE19-9C91-4DEE-BADF-93AE3.., GUID
Last Status (0] Operation successful, SAM Acco.. | Everyone
Domain BUILTIN
SID 5-1-1-0

Lact Chatie | (0 Nimarstine corceaccful

oK Cancel Apply

Total Entries: 2 Mapped Entries: 2

The page displays an initial identity map with a small number of suggested entries that you can
append.

4 Do one of the following:

+ To import associations between users in eDirectory and Active Directory using a delimited
text CSV file, go to “Importing Identity Associations through Delimited Text” on page 16.

+ To associate the users between the two directory services yourself, go to “Creating Object
Associations” on page 21.

Importing Identity Associations through Delimited Text

If you have a delimited text CSV file that associates eDirectory user and group objects with Active
directory user and group objects, you can import it into the identity map using the Import Identity Map
from Delimited Text option.

The CSV file can have entries using either typeful or typeless Fully Distinguished Names (FDNs).
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Mj Identity Map example.csv - Notepad — O *
File Edit Format View Help

cn=acox.ou=employees.ou=hq.o=corp,dynamics\acox
cn=ajames.ou=employees.ou=atlanta.o=corp,dynamicsiajames
cn=amartin.ou=employees.ou=london.o=corp,dynamicsiamartin
cn=ebrown.ou=employees.ou=hq.o=corp,dynamics’ebrown

1 Select Load > Import Identity Map from Delimited Text.

Import Identity Map Entries Wizard = m] X
Import [dentity Map Entries
Load File
Options
Import File Browse Reload

Source Type | FDN
Target Type | SAM Account
Preview

Select Al [ ] Deselect All | Count: 0

Source Target Status

2 Click Browse.

3 Select the CSV file, then click Open.
The following page appears and specifies whether the names in the CSV file are formatted
properly.
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Import Identity Map Entries Wizard

Import ldentity Map Entries

Load File
Options

Impart File | C\Users\administrator. DYMAMICS\Documentsildentity Map example.csv Browse Reload
Source Type | FDN -

Target Type | SAM Account -

Preview

Select Al [ ] Deselect All | Count: 4

Source Target Status
cn=acox.ou=employees.ou=hg.o=corp dynamicshacox

W ch=ajames.ou=employees. ou=atlanta.o=corp dynamicsiajames

W cn=amartin.ou=employees.ou=london.o=corp dynamicshamartin

W ch=ebrown. ou=employees. ou=hq.o=corp dynamicstebrown

4 (Conditional) If incorrect options in the Source Type or Target Type fields are displayed, select
the correct options.

5 Click Next.

The following page appears and specifies whether the user and group objects exist in eDirectory
and Active Directory.
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Import Identity Map Entries Wizard

Import [dentity Map Entries
Verify Entries
Results
Select All [ ] Deselect All
Saurce Target SAM Account Current Target
v| X cn=Acoxou=empL. & CN=Amanda Cox,OU.. DYNAMICS\acox
v| | & CH=AJAMES.OU=EMP.. &b CN=Adam James,OU=.. DYNAMICS\ajames
v & cu=amerTiN.OU=E.. J CN=Alex Martin,OU=.. DYNAMICS\amartin
v | & CHN=EBROWN.OU=E.. Qb CN=Edward Brown,0.. DYNAMICS\ebrown
Mext =
Click Next.
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Import Identity Map Entries Wizard

Import ldentity Map Entries

Update Identity Map

Results

1 - Adding mapping for 'ACOX.EMPLOYEES.HQ.CORP' to 'Amanda
Cox.Employees.HQ.DYNAMICS.dynamics.cctec.org'

2 - Adding mapping for 'AJAMES.EMPLOYEES.ATLANTA.CORP' to ‘Adam
James.Employees.Atlanta.DYNAMICS.dynamics.cctec.org'

3 - Adding mapping for 'AMARTIN.EMPLOYEES.LONDON.CORP' to 'Alex
Martin.Employess.London.DYNAMICS.dynamics.cctec.org’

4 - Adding mapping for 'EBROWN.EMPLOYEES.HO.CORP' to 'Edward
Brown.Employees.HQ.DYNAMICS.dynamics.cctec.org'

Cancel
7 Click Finish.
Identity Map a X
/ Identity Map Entry Wizard & Manage Map Entries ~ Lp Source Paths - g Load ~ E Save o Reload G Refresh
Source FDN = Target FDN Target SAM Account Browse Target | SearchTarget | Well-known SIDs
[Publid] x Everyone BUILTIN\Everyone 3 Refresh
[Supervisor] Local System BUILTIM\Local System
« /N dynamics.cctec.org
& ACOXEMPLOYEESHQ.CORP B Amanda Cox.EmployeesHQ.. DYNAMICS\acox , T Buitin
& AAMES EMPLOYEESATLAN... | Jb Adam James.Employees Atl.. | DYNAMICS\ajames » T Computers
& AMARTIN.EMPLOYEES.LON... | &/ Alex Martin.Employess.lon.. | DYNAMICS\amartin » T Domain Controllers
& EEROWN.EMPLOYEESHQ.C.. | Edward Srown.Employees.. | DYNAMICS\ebrown » Ty DvnamMICS
» 'Eg ForeignSecurityPrincipals
» T:'g Keys
» Tg Managed Semice Accounts
» 'Eg Program Data
» 'Eg Service Accounts
» T:'g System
» To Users
FDN [Public] FDMN Everyone -
Type Index (21) Pseudo Security Principal Type Index (2) Group
Class Name = cce-PseudoSecurityPrincipal Class Name = Built-In
GUID {TO1ESE19-9C91-4DEE-BADF-93AES... GUID
Last Status (0] Operation successful, SAM Acco.. | Everyone
Domain BUILTIN
SID 5-1-10
-
Lack Ghatie | i Nnarstinn succaccful
oK LCancel Apply

Total Entries: & Mapped Entries

8 Click Apply to save the updated identity map.
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9 (Conditional) If you have additional users to import from another delimited text CSV file, select

the new CSV file and repeat the procedures in this section.

10 (Conditional) If you need to add additional users that were not listed in the CSV file, proceed to
“Creating Object Associations” on page 21.

Creating Object Associations

1 Click Identity Map Entry Wizard.

Identity Map Entry Wizard

Matching Scope

Match Type

Match source

Target Matching Pattern

Source Scope

Search Base

v | Search Subtree

Target Scope

Search Base

v | Search Subtree

Identity Map Entry Wizard

Select Options for Matching Criteria

®  Userto User
Group to Group

Container to Group

Commaon Mame.., -

*

[Rioot]

ﬂ Subtree searches are limited to a single Domain in Active Directory,

to target

S5AM Account ...

Erowse

Erowse

2 In the Matching Scope region, leave the User to User option selected and from the to target
drop-down menu, specify if the target accounts to locate are SAM accounts or Common Name

(CN) accounts.

If you need to match using both account types on your target server, you can choose one option
now and then run the wizard again and choose the other option. You might need to run the
wizard multiple times in order to add all of the users, groups, and containers to the identity map.

3 In the Source Scope region, browse to and select the source container with the users you want
included in the identity map.

4 In the Target Scope region, browse to and select the target container with the users you want
included in the identity map.
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5 Click Next.

Identity Map Entry Wizard

Identity Map Entry Wizard

| Generate Identity Map

Matching Results

Select All

<]|[<]|[<][[<][=]I[<] [=][[<]|[=]|[«] [

I L L I L

Source (41)

ACOX.EMPLOYEES...
AJAMES EMPLOYE...
AMARTIN.EMPLOY...
ANANCE.EMPLOY..,
AROOMNEY.EMPLO...
ATAFT.EMPLOYEE...
BADAMS, EMPLOY...
BCAGNEY.EMPLO..,
BCLARK.EMPLOYE...
BELOMEBARDILEMP..,
BSTREISAND.EMP..,

[] Deselect All

I L L I L

73 Rebuild

Target

Amanda Cox.Emp...
Adam James.Empl...
Alex Martin.Empl...
Alicia Nance.Empl...
Alice Rooney.Emp...
Amelia Taft.Emplo...
Brenda Adams.E...

Een Cagney.Empl...
Erian Clark.Emplo...
Eret Lombardi.Em...

Erenda Streisand....

+" = Entry already assigned to the matched target

ﬂ = Entry assigned to the [Do Not Translate] target

I, = Entry assigned to an existing target

SAM Account
DYMAMICS \acox
DYMAMICS \ajames
DYMAMICS amartin
DYMAMICS\anance
DYMAMICS \arooney
DYMAMICS \ataft
DYMAMICS \badams
DYMAMICS\becagn...
DYMAMICS\belark
DYMAMICS\blomb...
DYMAMICS\bstrei...

Current Target

Source Objects Loaded:

Target Objects Loaded:

MNext =

130

110

6 Select the names you want appended to the identity map file.

7 Click Next.
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Identity Map Entry Wizard = m] x

Identity Map Entry Wizard

Import Map Entries

Results

1: Adding source entry 'ACOX.EMPLOYEES.HO.CORP' with target 'Amanda -
Cox.Employees.HQ.DYNAMICS.dynamics.cctec.org’

2: Adding source entry 'AJAMES.EMPLOYEES.ATLANTA.CORP' with target 'Adam
James.Employees.Atlanta.DYNAMICS.dynamics.cctec.org’'

3: Adding source entry 'AMARTIN.EMPLOYEES.LONDOM.CORP' with target 'Alex
Martin.Employess.London. DYNAMICS.dynamics.cctec.org'

4: Adding source entry '"ANANCE.EMPLOYEES.ATLANTA.CORP' with target "Alicia
Mance.Employees.Atlanta.DYNAMICS.dynamics.cctec.org’

5: Adding source entry 'AROONEY.EMPLOYEES.NYC.CORP"' with target "Alice
Rooney.Employess.NYC.DYNAMICS.dynamics.cctec.org'

6: Adding source entry 'ATAFT.EMPLOYEES.HOQ.CORP' with target 'Amelia

Taft.Employees. HO.DYNAMICS.dynamics.cctec.org'

7: Adding source entry 'BADAMS.EMPLOYEES.ATLANTA.CORP' with target 'Brenda
Adams.Employees.HQ.DYNAMICS.dynamics.cctec.org’

8: Adding source entry 'BCAGNEY.EMPLOYEES.NYC.CORP' with target 'Ben
Cagney.Employess.N¥C.DYNAMICS.dynamics.cctec.org’

9: Adding source entry 'BCLARK.EMPLOYEES.HQ.CORP" with target 'Brian
Clark.Employees.HO.DYNAMICS.dynamics.cctec.org’

10: Adding source entry 'BLOMBARDI.EMPLOYEES.NYC.CORP' with target 'Bret
Lombardi.Employess.NYC.DYNAMICS.dynamics.cctec.org' M

+ | Auto-save |dentity Map updates to the Engine

Finish Cancel

8 Click Finish.
The identity map is appended with the new entries.
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Identity Map

f Identity Map Entry Wizard & Manage Map Entries~ | T Source Paths -

Source FDMN Target FON
[Public] .b'- Everyone
[Supervisor] Local System

=& ACOK.EMPLOYEES.HQLCORP & Amanda Cox.Employees.H...
|& AJAMES . EMPLOYEES. ATLA... & Adam James.Employees. Atl..
& AMARTIN.EMPLOYEES.LOM... & Alex Martin.Employess.Lon...
f& ANANCE.EMPLOVEES.ATLA... & Alicia Mance Employees. Atl...
& ARCOMEY.EMPLOYEES.NYC... & Alice Rooney.Employess.N...
& ATAFT.EMPLOYEES. HQ.CORP & Amelia Taft.Employees. HQ....
& BADAMS.EMPLOYEES.ATLA... & Brenda Adams.Employees....
I& BCAGMNEY.EMPLOYEES.NVC.... & Ben Cagney.Employess.NV...
:& BCLARK.EMPLOYEES.HQ.C.. | B Brian Clark.Employees HQ....
& BELOMBARDI.EMPLOYEES.N... & Bret Lombardi.Employess....
& BSTREISAND.EMPLOYEES.N... & Brenda Streisand.Employe...

|| FDN [Publi] FDN
Type Index (21) Pseudo Security Principal Type Index
Class Name | cce-PseudoSecurityPrincipal Class Name
|| GUID {701ESE19-9C51 4DEE-BADF-93AES... GUID
| Last Status (0) Operation successful. SAM Acco...
| Domain
5D

Lact Satuc

Total Entriess 43 Mapped Entries: 43

Target SAM Account
BUILTIN\Everyone
BUILTIM'Local System
DYNAMICS\acox
DYNAMICS\ajames
DYNAMICS amartin
DYNAMICS\anance
DYNAMICS\arooney
DYNAMICS\ataft
DYNAMICS \badams
DYNAMICS\bcagney
DYNAMICS\bclark
DYNAMICS\blombardi
DYNAMICS\bstreisand

Everyone
(2) Group
Built-In

Everyone
BUILTIM
5-1-1-0

1M Nnaration coccascful

¥ Load ~

A Save (_5 Reload G Refresh
Browse Target Search Target ‘Well-known SIDs
G Refresh

» /N dynamics.cetec.org

OK Cancel Apply

9 Click OK to save the updated identity map.

10 Repeat Step 3 and Step 4 and select the account type you did not select previously.

11 Repeat Step 5 through Step 9.

1.5.2 Importing a Source Path List

Depending on the size of your network, you might need to specify a significant number of different

source paths as you build your identity map. You can easily import a list of your UNC paths from a text
file so that these paths are accessible from a drop-down menu. Additionally, the search is filtered so
that it can locate the specific UNC path as you type.

1 Using a text editor, create a file with UNC paths for each server and volume that you want to

import, then save the file.

Mj Migration UMC Paths.tt - Notepad
File Edit Format View Help

‘woesllfmshatlvoll
YWhoesllfmsihgvoll
“oesllfmshlonvoll
“hoesllfmshnycvoll
“oesllfmsywault

2 In the Admin Client, click the Cross-Empire Data Migration tab.

3 Click eDirectory to Active Directory.
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4
5

6

Select Source Management > Source Path Cache.

Click Load, browse to and select the text file, then click Open.

Manage Source Paths X

== Remove = 3=] Load

Source Path

YWhoes11fmsiathvoll

“Wwoes11fms\hguoll
Ywoes11fmsilonvoll
‘woes11fmsynyovoll

Ywoes11fms\wvault

oK Cancel

Click OK.

1.5.3 Adding Source Entries to the Identity Map

To append additional users or groups to the identity map from the eDirectory source:

a H WO N =

In the Admin Client, click the Cross-Empire Data Migration tab.
Click eDirectory to Active Directory.

Select Identity Map Management > Edit Identity Map.

Select Manage Map Entries > Add Source Entries.

In the Add Source Objects page, use the Search Base, Browse button, Search Scope, and
Name Mask fields to locate and select the container you want to use for your search.

If you wish to limit your search to a selected set of object types, under the Class heading,
deselect those object types you do not want included in the search.

6 Click OK.
7 On the Add Source Object page, click Search.
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Add Source Objects = (m] x

Search Options Search Results
Search Base | [ROOT] Erowse Select Al [] Deselect All | Selected (4)
MName Mask | admin*
/ |Search Subtree Search Enter text to search, - Find Clear
_ FDN (4} Class
Object Classes
b .ﬂ- admin.Tomeat-Roles.system Group
Select Al [] Deselect All | Selected (431) +| 2% admingroup.system Group
b AdminQFServer. QFSearch.Role Based Service 2.system Unknown
Find Clear o & admin.system User
Class (431}
e e account -

7| @ acspolicy

+ 0 aC5Resourcelimits

V| @ acssubnet

J 9 addressBookContainer

| @ addressTemplate

J e AFP Server

v | @ nias

J e apchadmnConfiguration

J 0 apchadmnConfigurationBlock
o 0 apchadmnhodule

o 0 apchadmnServer

| @) apchadmnVirtualHost W

oK Cancel

8 In the right pane, select the objects you want to append to the identity map.
9 Click OK.

1.5.4 Adding or Modifying Target Entries to the Identity Map

1 In the Admin Client, click the Cross-Empire Data Migration tab.
2 Click eDirectory to Active Directory.

3 Click Identity Map Management.
4

In the Identity Map page, select the listing for the source entry to which you want to add a target
or that you want to modify.

5 Use one of the tabs in the right panel of the Identity Map page to locate and select the desired
target.
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Identity Map =

/ Identity Map Entry Wizard

admingroup.system
AJAMES.EMPLOYEES. ATLA...
AMARTIM.EMPLOYEES.LON...
AMAMCE EMPLOYEES ATLA...
AROOMEY.EMPLOYEES.NYC. .
ATAFT.EMPLOYEES.HG.CORP
BADAMS.EMPLOYEES. ATLA...
BCAGMNEY.EMPLOYEES.NYC....

Bl ol e b

BCLARK.EMPLOYEES HOQ.C...

bedededele e b b

FDM admin.system
Type Index 1) User

Class Name | User

Last Status (0) Operation successful.

Total Entries: 45 Mapped Entries:

¢ Manage Map Entries ~

Everyone

Local System

Source FDN = Target FOM
[Public] 1n
[Supervisor] E
ACOX.EMPLOYEES.HQ.CORP &

Amanda Cox.Employees.H...
admin.system [Do Mot Translate]

[Do Mot Translate]

Adam James.Employees.Atl..
Alex Martin.Employess.Lon...
Alicia Mance Employees.Atl...
Alice Rooney.Employess.N...
Amelia Taft.Employees.HQ....
Brenda Adams.Employees....
Ben Cagney.Employess.NY...
Brian Clark.Employees.HQ....

GUID {A474ES6A-3802-4F46-8382-6AE574...

T—_\ Source Paths -

Target SAM Account
BUILTIM\Everyone
BUILTIM\Local System
DYNAMICS\acox

DYNAMICS\ajames
DYNAMICS\amartin
DYNAMICS\anance
DYNAMICS\arooney
DYNAMICS\ataft
DYNAMICS\badams
DYNAMICS\bcagney
DYNAMICS\bclark

Load -

(_5 Reload G Refresh
Browse Target Search Target Well-known 5I1Ds

G Refresh

.|,l- Cloneable Domain Controllers

.ﬂ- Denied RODC Password Replication Group

.ﬂ- DnsAdmins
ﬂ DnsUpdateProxy

D

;l- Domain Computers

.ﬂ- Domain Controllers

# Domain Guests

2% Domain Users

;l- Enterprise Admins

.ﬂ- Enterprise Key Admins

.ﬂ- Enterprise Read-only Domain Controllers
ﬂ Group Policy Creator Owners
;l- Key Admins

.ﬂ- Protected Users

.ﬂ- RAS and |AS Servers

ﬂ Read-only Domain Controllers
;l- Schema Admins

; Administrator

‘ DefaultAccount

; Guest

2 kbtat

oK Cancel

Apply

6 Specify the object as the new target object.

For example, if you were using the Browse Targets tab in the example above, you could right-

click or drag the object to place it in the Target SAM Account field of the selected source object.

Identity Map

admingroup.system

ebe e bedededelbe i lhelbe

=
o

N admin.system
Type Index (1) User

Class Name | User

Last Status (0] Operation successful,

/ Identity Map Entry Wizard & Manage Map Entries ~

Source FDOM = Target FON
[Public] » Everyone
[Supervisor] E Local System

ACOX.EMPLOYEES.HQ.CORP & Amanda Cox.Employees.H..
admin.system d- Domain Admins, Users.dyn...
[Do Mot Translate]

AJAMES EMPLOYEES.ATLA... x Adam James.Employees.Atl...
AMARTIN.EMPLOYEES.LON... & Alex Martin.Employess.Lon...
AMANCE.EMPLOYEES.ATLA... & Alicia Mance.Employees.Atl...
AROOMEY.EMPLOYEES. MYC... & Alice Rooney.Employess.M...
ATAFT.EMPLOYEES.HQ.CORP & Amelia Taft.Employees.HQu.
BADAMS EMPLOYEES.ATLA... & Brenda Adams.Employees....
BCAGMEY.EMPLOYEES.MYC.... & Ben Cagney.Employess.MY...
BCLARK.EMPLOYEES.HQ.C... & Brian Clark.Employees.HQ....

GUID {A4T4ES6A-3802-4F46-8382-6AE5T4..,

LpSourcePaths' gLoad'

Target SAM Account
BUILTIM\Everyone
BUILTIM\Local System
DYNAMICS\acox
DYNAMICS\Domain Admins

DYNAMICS\ajames
DYNAMICS\amartin
DYNAMICS\anance
DYNAMICS\arooney
DYNAMICS\ataft
DYNAMICS\badams
DYNAMICS\bcagney
DYNAMICS\bdlark

o Reload G Refresh
Browse Target Search Target Well-known 51Ds

G Refresh

ﬂ Cloneable Domain Controllers

,II\ Denied RODC Password Replication Group
.Ilv DnsAdmins

.Ilv DnsUpdateProxy

T

ﬂ Domain Computers

,II\ Domain Controllers

.Ilv Domain Guests

.ﬂv Domain Users

ﬂ Enterprise Admins

ﬂ Enterprise Key Admins

ﬂ Enterprise Read-only Domain Controllers
.Ilv Group Policy Creator Owners
.ﬂv Key Admins

ﬂ Protected Users

ﬂ RAS and IAS Servers

ﬂ Read-only Domain Controllers
.Ilv Schema Admins

& Administrator

& DefaultAccount

& Guest

X krotat

oK Cancel

Apply

7 Click Apply to save the modified identity map.
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1.5.5

1.5.6

1.5.7

Saving a Local Instance of the Identity Map

When working with identity maps, you might find that you want to experiment with different
associations. In such cases, you should have multiple identity maps. To save an identity map that
differs from the original, you must save it locally.

1 Click Save.
2 Save the XML formatted identity map file to a location you prefer.

Loading a Saved Identity Map

This action retrieves saved versions of identity maps.

1 Select Load > Load Identity Map File.
2 Select the file, then click Open.

Generating a Migration Preview Report

Before performing a Cross-Empire Data Migration, you should generate a preview report. The report
indicates any concerns that might need to be addressed such as objects which have file rights but
which have not yet been mapped in the identity map.

The preview report uses your identity map, and searches file and folder rights assignments and
ownership of the actual data which you will be migrating to indicate which objects actually have
ownership or rights, and if an object is mapped in the identity map.

1 In the Admin Client, click the Cross-Empire Data Migration tab.

2 Click eDirectory to Active Directory.

3 Select Identity Map Management > Edit Identity Map.

4 Select Source Paths > Generate Preview Report.
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Preview Migration Source Paths = (m] X

,/’ManageSour(ePaths Path Scan Options: | Scan File Owners

Base Path | Enter or select an initial UNC path - Browse Path

Trustee Entries (0} Owner Entries (0} Unigue IDs (0}

Trustee Path Assigned Rights Target Trustee Target Rights Last Error

Add Entries Close

A Unmapped Trustees: 0 A Unmapped Owners: 0 i Missing Owners: 0

5 In the Base Path field, do one of the following:
+ Select an imported source path
+ Specify an initial UNC path for a server and volume to browse
For example, \\ ser ver _narne\ vol une_nane\
or
\\i p_addr ess\ vol unre_nane\

After you enter a path, you can click the Browse button to browse to the folder you want,
such as the User s folder.

6 Drag the selected folder to the Path pane.
7 From the Path Scan Options drop-down menu, choose one of the following:

¢ Scan Folders Only: Select this option to view the trustee assignments and owners of
folders.

¢ Scan File Owners: Select this option to view the trustee assignments and owners of folders,
along with the owners of files.

¢ Scan File Owners and Permissions: Select this option to view the trustee assignments and
owners of folders, as well as the trustee assignments and owners of files.

Depending on the number of files and folders on your Novell or Micro Focus network, the
Scan File Owners and Permissions option can take a significant amount of time to
generate. We recommend using one of the other options first.
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8 From the Report Type drop-down menu, choose one of the following:

¢ Full Report: Depending on which of the File Scan Options are selected, this generates a
report of all of the folders and files, along with their corresponding owners and trustees, and
indicates whether they are mapped to a target object in the identity map or not.

Depending on the number of files and folders on your Novell or Micro Focus network,
generating a full report can take a significant amount of time. We recommend generating an
Anomaly report instead.

+ Anomaly Report: Depending on which of the File Scan Options is selected, this generates
a report of all of the folders and files that have trustees or owners that are not mapped to a
target object in the identity map.

9 Click Preview Paths.

Preview Migration Source Paths = a X
Preview Paths # Manage Source Paths  Path Scan Options: | Scan File Owners = | Report Type: | Full Report - == Remove
o 2 P P P
Base Path | “\oes11fmsthavaoll - Browse Path
+ = havalt «| | ‘ioes11fms\hquol1\DEPARTMENTS
55 Trash-0

T DEPARTMENTS
T3 Filr Access

5 HRDEPT

HSM TEMPLATES
PROJECTS

T3 TRAINING

Trustee Entries (9] Owner Entries (215) Unique IDs (12}

Trustee Path Assigned Rights Target Trustee Target Rights Last Error
m o [Inherited Rights Mask] =7 WOESTIFMS\HQVOLT... S (0} Operation successful.
& + dawson EMPLOYEES... 55 WOESTIFMS\HQUOL1... = SRWECMFA & CarlLawson.Employe..  FMELRW (0} Operation successful.
&-’- +" Finance Dept.HO.CORP £ WOEST1FMS\HOVOL1.. = RWECMF L-’- Finance Dept.Groups... MELRW (0) Operation successful.
.{l + HQMarketing.HQ.CO... 55 WOESTIFMS\HQVOL1... | RWECMFA ;3- HQ Marketing.Group... FMELRW (0} Operation successful,
;l + HQMarketing. HQ.CO... |55 WOEST1IFMS\HQVOL1...  RF L‘- HQ Marketing.Group...  ELR (0} Operation successful.
Ik o HOSales.HOL.CORP =5 WOESTIFMS\HOVOL1... | RF 2% HO Sales.Groups.HQ...  ELR {0} Operation successful.
&-’- +" HQ Sales.HQ.CORP =5 WOESTIFMS\HOVOLT., | RWECMFA L-’- HQ Sales.Groups.HQ...  FMELRW (0} Operation successful,
.1-'- «" IT Administrators.HQ.... T3 “oes11fms\hguol1\D.. = RWECMFA ;3- IT Administrators.Gro... ~ FMELRW (0} Operation successful.
;l I, Medical Team.HQ.CORP 55 WOESTIFMS\HQVOL1... | RWECMF a (0} Operation successful.

Add Entries Close

A\ Unmapped Trustees: 1 f} Unmapped Owners: 40 (i Missing Owners: 0

10 Use the tabbed reports to preview targets according to trustees, owners, and unique IDs.

For example, in the graphic above, the Trustee Entries tab displays the source IDs that have a
trustee assignment to a folder but a target ID has not yet been created in the identity map.

The Owner Entries tab displays owners of files and folders that do not have a corresponding
target in the identity map.

The Unique IDs tab displays a single entry for each ID that is mapped in the identity report.
11 Click Add Entries to append the entries to the identity map.

The entries are added to the identity map and you can now add target entries by following the
procedures in Section 1.5.4, “Adding or Modifying Target Entries to the Identity Map,” on
page 26.
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1.5.8

Adding Entries from Preview Reports

In Step 11 on page 30, you added entries to the identity map by using the Preview Migration Source

Path page’s Add Entries button. You can also use the Add Entries from Preview Report option to
retrieve any preview report that you have generated for the directory tree you are working with, and
add those entries to the identity map.

1 In the Admin Client, click the Cross-Empire Data Migration tab.

2 Click eDirectory to Active Directory.

3 Select Identity Map Management > Edit Identity Map.

4 Select Source Paths > Add Entries from Preview Report.

5 From the Browse Migration Preview Reports dialog box, select the preview report you want to

add, then click OK.

View Report

=] ]
&V
v
v
® v
® v
v
v
ar v

Trustee Entries (9]

(o CV [ HTML

Source:
Target:
Administrator:
Report Type:
Include Files:
Fath:

Trustee

[Inherited Rights M...
clawson.EMPLOYEE...
Finance Dept.HQ.C...
HQ Marketing HQ.C...
HQ Marketing HQ.C...
HQ Sales.HQ.CORP
HQ Sales.HQ.CORP
IT Administrators.H...

Medical Team.HQ.C...

Owner Entries (215)

Preview Migration Source Paths

MFMS_TREE
dynamics.cctec.org

DYNAMICS\Administrator

Full Report
Scan file owners

‘woes11fms\hquol1\DEPARTMENTS

Fath

WOESTIFMS\HOVO..,
WOESTIFMSWHOQVO...
WOESTIFMS\HOV ...
WOESTIFMS\HOV ...
WOESTIFMS\HOV ...
WOESTIFMS\HOV O,
WOESTIFMS\HOV ...
Voes11fms\hgvol ..

WOESTIFMS\HOVO...

Unigue IDs (12}

Assigned Rights
S

SRWECMFA
RWECMF
RWECMFA

RF

RF

RWECMFA
RWECMFA
RWECMF

Target Trustee

& carlLawsonEmploy..
.ﬂ- Finance Dept.Grou...
2% HQ Marketing.Grou...
A% HQ Marketing.Grou..,
.l.ﬁ- HQ Sales.Groups.H...
2% HQ Sales.Groups.H...
.ﬂ- IT Administrators.Gr..

[Do Mot Translate]

Target Rights

FMELRW
MELRW
FMELRW
ELR

ELR
FMELRW
FMELRW
MELRW

Last Error

(0} Operation successful,
[0) Operation successful,
(0} Operation successful,
(0} Operation successful,
(0} Operation successful,
(0} Operation successful.
(0} Operation successful,
(0} Operation successful,

(0} Operation successful.

At this point, you can view the preview report according to the tabbed options.
6 Click Add to add the entries to the identity map.

The entries are added to the identity map and you can now add target entries to each by
following the procedures under Section 1.5.4, “Adding or Modifying Target Entries to the Identity

Map,’

" on page 26.
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1.5.9 Review Rights and Trustee Assignment Mappings

Despite the inherent differences in rights, trustee assignments, and permissions between Novell or
Micro Focus networks and Microsoft networks, the Cross-Empire Data Migration subsystem of File
Dynamics does its best to match the Novell or Micro Focus rights and trustee assignments with the
equivalent Microsoft permissions and advanced permissions.

When you generate a Preview Report, you should pay particular attention to the actual rights in the
Assigned Rights column and the proposed file and folder rights listed in the Target Rights column.

You can modify the rights mappings by using the File System Rights Map. When you do this, you
specify a mapping between one particular set of rights on the Novell or Micro Focus servers to one
particular set of rights on the Microsoft Windows servers. As an example, the default mapping is to
map the Novell or Micro Focus NSS rights RWECMF to the Windows NTFS rights MELRW. As a
further example, perhaps when files have this set of rights you do not want to grant the E (erase) right
to files on the target. You could modify the mapping using the procedures below to change the
mapping of Novell or Micro Focus NSS rights RWECMF to the Windows NTFS rights MLRW. When
you do this, you change the mapping for every file that has that exact set of rights, but it does not
change the E mapping in any other set of rights. For instance, if you had trustees that had RWCEF,
that mapping would not be changed because you changed the mapping for RWCEMF.

To view or modify these rights:

1 In the Admin Client, click the Cross-Empire Data Migration tab.
2 Click eDirectory to Active Directory.
3 Select Identity Map Management > File System Rights Map.

Data Migration File System Rights Map - X
Path Type | Folder - | Show Advanced Permissions 32| Load H 5ave
Custom Entries NSS Rights

Read

Write

Create

Erase

Madify

File Scan
Access Control

Supervisor

oK

4 In the NSS Rights column, click the rights to see the equivalent NTFS permissions and
advanced permissions.
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1.6

1.6.1

Data Migration File System Rights Map = x

Path Type Folder - +| Show Advanced Permissions E Load E Save
Custom Entries NSS Rights NTFS File System Rights
T3 RWCEFA + | Read Permissions Advanced Permissions
+ | Write

Full Control +' | Write Attributes

+' | Create

~ | Modify | Traverse Folder / Execute File | Write Extended Attributes
+ | Erase
+'| Read and Execute +'| List Folder / Read Data Delete Subfolders and Files
Modify
+'| List Folder Contents +'| Read Attributes + | Delete
~' | File Scan
~' | Read +'| Read Extended Attributes +'| Read Permissions
+' | Access Control
" | Write ' | Create Files / Write Data Change Permissions
Supervisor
Special +' | Create Folders / Append Data Take Ownership

- oPEm‘HSiiUI’]S in green are the default permissions for the selected rights map entry
Reset to Defaults

Remove Entry IR
== Add Remove
Basic Advanced Applies To
MELRW  Tf Ex, Lf Rd,Ra,Rx, Cf,Wd,Cs,Ad,Wa,W... This Folder, Subfolders, Files
oK Close Apply

The default permissions are indicated in green.
5 Select or deselect permissions as needed.
6 Click Apply to save the settings.

Migration Options

The eDirectory to Active Directory Cross-Empire Data Migration subsystem of File Dynamics
provides the following options for migration:

¢ Section 1.6.1, “Data and Security,” on page 33
+ Section 1.6.2, “Data Only,” on page 34
¢ Section 1.6.3, “Security Only,” on page 34

Data and Security

This option migrates the data and the associated folder and file rights and trustee assignments
specified in the identity map.

NOTE: The initial identity map referenced in Step 3 on page 15 does not function as an identity map
until you have appended entries to it.

The procedures that begin in Section 1.8, “Performing a User to User Data Migration,” on page 35
use the Data and Security option.
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1.6.2 Data Only

This option migrates only the data and not the associated rights and trustee assignments. After you
have migrated the data, you can later go back and apply the file rights and trustee assignments to the
data through the Security Only option.

When data is migrated by using this option, file ownership is set according to the File Dynamics policy
for the migration target. If there is no policy in place, the owner is the File Dynamics proxy user in
Active Directory.

In the procedures included in the remainder of this section, the Copy Options - Rights and Ownership
page is not applicable for a Data Only migration.

1.6.3 Security Only

This option migrates the rights and trustee assignments of data that has already been migrated. If the
data to which the trustee assignments are assigned has not been migrated, the associated rights and
trustee assignments for those files or folders are not migrated.

If you attempt to use this option and you have not created an identity map, you cannot proceed.

This option is frequently used when migrating the rights and trustee assignments from a single Novell
or Micro Focus source to a remote Windows Server that does not have an installed Client for OES.

1.7 Viewing the Migration Log File

The migration log file can be used to track the status of the migration. You can view the file by using a
Windows tail program or an application such as dbgvi ew. exe.

To view the log file using dgbvi ew. exe, refer to the application’s documentation for configuring and
viewing log file data.

Procedures for viewing the log file data using a Windows tail program follow:
1 Download a Windows tail program and install it on the Engine host or the Cross-Empire Data
Migration enabled File System Agent tasked with the migration.

To verify that the File System Agent is Cross-Empire Data Migration enabled, refer to the Agent
page in the Admin Client. For more information, see Agents in the Micro Focus File Dynamics
6.5 Administration Guide.

2 Do one of the following:

+ If the server to which you are migrating data is running a Cross-Empire Data Migration
capable File System Agent, or is set up to be proxied by a Cross-Empire Data Migration
capable File System Agent, at the File System Agent server, use the Windows tail
application to open the log file at:

C.\ ProgranDat a\ M cro Focus\Fi | e Dynami cs\ Agent\| og\ f sagent - xxx. | og

+ |f the server to which you are migrating data is not running a Cross-Empire Data Migration
capable File System Agent, and is not set up to be proxied by a Cross-Empire Data
Migration capable File System Agent, at the Engine server, use the Windows tail application
to open the log file at:

C.\ ProgranDat a\ M cro Focus\ Fi | e Dynami cs\ Engi ne\ | og\ engi ne- xxx. | og
3 Refer to the log file during the migration to view the status.
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1.8 Performing a User to User Data Migration

1 Make sure you have completed the prerequisites and have created a migration proxy account.
For more information on the prerequisites, see Section 1.3, “Prerequisites,” on page 11. For
more information on creating a migration proxy account, see Section 1.4, “Creating the Migration
Proxy Account,” on page 13.

2 In the Admin Client, click the Cross-Empire Data Migration tab.
3 Click eDirectory to Active Directory.
4 Select Migration Wizards > Data and Security.

Cross-Empire Data Migration Wizard - Data and Security X

Migration Type

Select Migration Type Options
Migration Type
Select from the following types of migrations:
User to User - maps source and target based on the selected folder type for users.

Folder to User - maps folders from the source tree to the selected folder type for users in the target
tree

Group to Group - maps source and target based on the home folder for selected groups
Folder to Group - maps folders from the source tree to the home folder for groups in the target tree
Folder to Folder - maps folders from the source tree to a folder in the target tree

Path Type
Select the path type for migration. Selection choices only apply to user folder migrations.

4
Migration Type Options

Migration Type
Path Type -

5 From the Migration Type drop-down menu, select User to User.

6 From the Path Type drop-down menu, select the target path type for the data that you will
migrate.

For example, if you select Home Folder, the data is copied to each user's home folder path as
defined in directory services.

7 Click Next.
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Cross-Empire Data Migration Wizard - Data and Security X

User to User

Define Automatic Mappings

Generate Automatic Mappings
Select this option to create auto-generated mappings between selected source and target objects
and folders. Object matching is based on the folder name, or on the object name. Object names
are derived from the Common Mame (CN) for eDirectory and from the SAM Account Name for
Active Directory.

Depending on the Migration Type previously selected, the mappings are built as follows:

Userto User/ Group to Group - select parent containers to automatically match source
objects to target objects based on object name.
For eDirectory, name is based on Common Mame or CH.
For Active Directory, the name is based on the SAM Account Mame.

Folder to User / Folder to Group - select a parent source folder and a parent target container.
Folder names from the source parent path are matched to object names in the selected
target container.

Folder to Folder - select a source parent folder and a target parent folder. Folder names from
the source parent path are matched to folder names in the selected target parent path.

Source Container / Source Folder
Salart the sniirre narant foldar nr narant containar tn eearch for matrheas Mota that nnbe the

Generate Automatic Mappings [Optional)

6 Click Mext to skip Automatic Mappings and continue with custom mappings.

Cancel

8 Do one of the following:
+ Fill in the following fields:

Generate Automatic Mappings (Optional): If you are migrating a large number of users,
select this check box to activate the other fields.

Source Container: Browse to select the source container.
Target Container: Browse to select the target container.

Include Source items not having a matching target: Indicate if you want to identify
source objects not having a matching target object.

+ If you are migrating only a few users, use the Add button on the next wizard page to add the
users individually.

9 Click Next.

The Data Migration Wizard attempts to match the Common Name (CN) of objects from the
eDirectory source with the SAM (Security Accounts Manager) Account Names in the Active
Directory target. If there is a match, the listed object in the Source Object field is selected and a
corresponding match is listed in the Target Object column.
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10

1"

12
13

14

Cross-Empire Data Migration Wizard - Data and Security

User to User

Define Mappings

o= Add == Remove = Edit
Source Object
AROOMEY.EMPLOYEES.NYC.CORP
BCAGMEY.EMPLOYEES.NYC.CORP
BLOMBARDILEMPLOYEES.MYC.CORP
BSTREISAND.EMPLOYEES.MYC.CORP
CREEVE.EMPLOYEES.NYC.CORP
DSTANWYCK.EMPLOYEES,NYC.CORP
FWOOLWORTH.EMPLOYEES. MYC....
GEASTMAN EMPLOYEES.NYC.CORP
JHOWE.EMPLOYEES.NYC.CORP
JIORDON.EMPLOYEES.NYC.CORP
KMERMAN.EMPLOYEES.NYC.CORP
LEALL.EMPLOYEES.NYC.CORP
MCOMBS.EMPLOYEES.NYC.CORP
MLAMGELLA EMPLOYEES NYC.CORP
PTIFFANY.EMPLOYEES. NYC.CORP
RWHITMAN. EMPLOYEES. NYC.CORP
SWHARTOM EMPLOYEES NYC.CORP

]| [ [ [ T[] T T = T T T [ [T =] =] <] 1<

TROCKWELL EMPLOYEES.NYC.CORP
~ | WIRVING, EMPLOYEES.MYC, CORP

Select=  [| Deselect ~

Target Object

Alice Rooney.Employess. NYC.DYN...
Ben Cagney.Employess. NYC.DYMNA...
Bret Lombardi.Employess. NYC.DY...
Brenda Streisand.Employess.NYC....
Charles Reeve.Employess.NYC.DY...
David Stanwyck.Employess.NYC.D...
Francis Woolworth.Employess.NY...
George Eastman.Employess. NYC....
Julia Howe . Employess.NYC.DYMA...
Jeffrey Jordon.Employess. MYC.DVY...
Karen Merman.Employess.NYC.DY...
Lauren Ball.Employess MYC.DYMNA...
Mark Combs.Employess NYC.DYM...
Mary Langella.Employess.NYC,DY...
Paul Tiffany.Employess. NYC.DYNA...
Ronald Whitman.Employess.NYC....
Sally Wharton.Employess. NYC.DY...
Tim Rockwell.Employess NYC.DYM...

Wallace Invina.Empolovess,MYC.DY...
Auto Map Count: 20 Total: 20 Selected: 20

¥=] Load H save

Target SAM
arooney
bagney
blombardi
bstreisand
creeve
dstanwyck
fwoolworth
geastman
jhowe
jiordon
kmerman
Iball
meombs
mlangella
ptiffany
rwhitman
swharton
trockwell

wirving

MNext =

Specify a target object for each source object that is not automatically matched by double-

clicking the name to bring up the Modify Data Map Entry dialog box.

Click Browse, specify the target object, then click OK.

The target object is displayed in the Target Object column.

Click the check box corresponding to the listing with the new target.

Repeat Step 10 and Step 11 to specify all target objects that are not listed.

To change the specified target object, use the Edit button.

To add an object to the Source Object column, use the Add button.

When all of the objects you want to migrate are selected and have an associated target object,

click Next.
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Cross-Empire Data Migration Wizard - Data and Security X

User to User

Data Copy Options
Policy Options

+' | Require use of Policies for target objects

Owverwrite Options

Mever Overwrite -

Directory Quota

Cio Mot Apply Source Directory Quota -

Target Subfolder

Use Subfolder

Cancel

15 Fill in the following fields:

Require use of Policies for target objects: If you are migrating data for objects to an Active
Directory container that has an associated File Dynamics policy, leave this check box selected.

If this check box is selected and there is no associated File Dynamics policy, the object’s data is
not eligible for migration.

Additionally, if you are migrating a user and the target user is not currently managed by an
associated policy, but the object does have a policy that would apply to it, then File Dynamics
automatically applies that policy to the target user.

If you are migrating object data to an Active Directory container that does not have an associated
File Dynamics policy, deselect this check box.

Overwrite Options: Indicate what you want to take place when duplicate filenames are
encountered in the source and target.

Directory Quota: Specify how quota settings from the source Novell or Micro Focus file system
should be applied after the migration.

Target Subfolder: If you want migrated data to be placed in a subfolder, select the Use
Subfolder check box and specify the subfolder name in the field.
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16 Click Next.

Cross-Empire Data Migration Wizard - Data and Security x

User to User

Rights and Ownership Copy Options
Ownership
Owner for Target Folder

Use Policy-Defined Path Owner - Browse

Cwerride policy owner setting
Owner for Target Folder Contents
Set to Target Object - Erowse
Override policy owner setting
Identity Map
Use |dentity Map ﬂldentity Map Entry Count: &4 |dentity Map

Cancel

17 Fill in the following fields:

Owner for Target Folder: Use these settings to specify how ownership of the migrated folder is
determined.
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If you selected the Require use of Policies for target objects check box in the previous wizard
page, only the Use Policy-Defined Path Owner and Set Explicit Owner options are available on
the drop-down menu.

+ Use Operating System Defaults: This default setting allows the target Microsoft Windows
Server to adjust the file ownership according to the settings on the target server.

+ Set to Target Object: Specifies the target object as the owner of the migrated files. If the
policy specifies a different owner, the policy’s owner is applied.

+ Use Policy-Defined Path Owner: Ownership of the files is determined according to the
settings in the File Dynamics policy associated with the container where the object is
managed.

+ Set Explicit Owner: Allows you to browse and select an object as the explicit owner of the
migrated folder, unless the policy specifies another object as the owner. To override the
policy’s configuration, select the Override policy owner setting check box.

Owner for Target Folder Contents: Use these settings to specify how ownership of the
migrated folder contents is determined.

If you selected the Require use of Policies for target objects check box in the previous wizard
page, only the Set to Target Object and Set Explicit Owner options are available on the drop-
down menu.

+ Use Operating System Defaults: This default setting allows the target Microsoft Windows
Server to adjust the file ownership according to the settings on the target server.

+ Set to Target Object: Specifies the target object as the owner of the migrated files. If the
policy specifies a different owner, the policy’s owner is applied.

+ Set Explicit Owner: Allows you to browse and select an object as the explicit owner of the
migrated files, unless the policy specifies another object as the owner. To override the
policy’s configuration, select the Override policy owner setting check box.

Use the Identity Map: Selecting this check box indicates that you want File Dynamics to utilize
the identity map you created earlier and use the corresponding IDs to copy security rights and
file ownership from the Novell or Micro Focus network file system to the Windows network file
system.

+ Transfer Rights and Ownership: Selecting this option indicates that you want to transfer
the file and folder security rights along with the ownership settings.

Be aware that when you transfer the ownership of a file or folder in a Windows network, you
are granting the owner Full Rights, which you might not want to provide.

+ Transfer Rights Only: Selecting this option indicates that you want to transfer only the file
and folder security rights.

+ Overwrite Trustees: Selecting this option indicates that you want any existing trustee
assignments for a target file or folder, to be overridden by the established eDirectory trustee
assignments for those files and folders.

+ Merge Trustees: Selecting this option indicates that you want the established eDirectory
trustee assignments merged with those of the target files or folders in the Windows file
system.

Identity Map: Clicking this button opens your identity map where you can make any desired
changes.

18 Click Next.

19 (Conditional) If you want to use a filter to include or exclude specific files, select the Use Copy
Filter check box and click the Add button.

19a Fill in the following fields:
Description: Specify a description of the filter.
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Action: From the drop-down menu, select either Migrate or Ignore, based on whether the
filter specifies to migrate files or folders or to ignore them.

Files, Folders: Specify if the filter applies to files or folders.

Masks: List the file types to migrate or ignore.

19b Specify any additional filter criteria in the menus and fields that remain.

For a detailed explanation of this region of the dialog box, see Setting Vault Rules in the

Micro Focus File Dynamics 6.5 Administration Guide.

19¢ Click OK
20 Click Validate

Validate shows the result of certain checks that can be run prior to the migration. The Result
column shows the status of the validation checks. If errors are displayed, you can choose to
correct those errors prior to running the migration.

Cross-Empire Data Migration Wizard - Data and Security

Validation Results

<[] =] [ T T ] T T [T T (T [T T (T [ T [ =
LA L L L4 L L4 LS L[ &

Select All

User to User

Validate Migration

(] Deselect All

Source

CN=AROOMNEY.OU=EMPLOYE...
CN=BCAGMNEY.OU=EMPLOYE...
CN=BLOMBARDI.OU=EMPLO...
CMN=BSTREISAND.OU=EMPLO...
CM=CREEVE.OU=EMPLOYEES...
CN=DSTANWYCK, OU=EMPLO..,
CN=FWOOLWORTH.OU=EM...
CHN=GEASTMAN.QOU=EMPLOY...
CN=JHOWE.QU=EMPLOYEES...
CN=JJORDOMN,.OU=EMPLOYE...
CHN=KMERMAN,OU=EMPLOY...

CMN=LBALL OU=EMPLOYEES....

CN=MCOMBS.OU=EMPLOYE...
CN=MLANGELLA,OU=EMPLO...
CN=PTIFFANY,OU=EMPLOYEE...
CN=RWHITMAN.OU=EMPLO...
CN=SWHARTON,OU=EMPLO...
CN=TROCKWELL QU=EMPLO...

Target

CN=Alice Rooney, OU=Emplo...
CN=EBen Cagney, OU=Employ...
CMN=Bret Lombardi,OU=Empl...
CN=Brenda Streisand, OU=E...

CN=Charles Reeve OU=Empl...
CN=David Stanwyck, OU=Em...
CN=Francis Woolwaorth, OU=...
CN=George Eastman, OU=Em...
CN=Julia Howe, OU=Emplaye...
CN=leffrey Jordon, OU=Empl...
CN=Karen Merman,OU=Empl...
CM=Lauren BEall, CU=Employ...

CN=Mark Combs, OU=Emplo...
CN=Mary Langella,OU=Empl...
CN=Paul Tiffany, OU=Employ...
CN=Ronald Whitman, OU=E...

CN=S5ally Wharton, QU=Empl...
CN=Tim Rockwell, OU=Emplo...

Result

Operation successful.
Operation successful.
Operation successful,
Operation successful.
Operation successful.
Operation successful,
Operation successful.
Operation successful.
Operation successful,
Operation successful,
Operation successful.
Operation successful,
Operation successful,
Operation successful.
Operation successful,
Operation successful,
Operation successful.

Operation successful.

Validate

Migrate

Cancel

21 (Conditional) Take any necessary action in the Windows network file system target and then
validate again.

22 Click Migrate.
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A page appears with details of the data migration events that are queued for processing. To view
the status of migration events, click Events. For more information on Events, see Pending

Events in the Micro Focus File Dynamics 6.5 Administration Guide.

Cross-Empire Data Migration Wizard - Data and Security

User to User
Perform Migration
Migration Results
Source Target Result

4" CN=AROOMEY.OU=EMPLOYEES... CM=Alice Rooney,OU=Employes... Successfully queued event,
" CN=BCAGNEY.OU=EMPLOYEES.... CN=Ben Cagney,OU=Employess... = Successfully queued event.
" CN=BLOMBARDI.QU=EMPLOYEE... CM=Bret Lombardi,QU=Employe... Successfully gueued event,
4" CN=BSTREISAMD.QU=EMPLOYEE... CM=EBrenda Streisand,OU=Empl... Successfully queued event,
4" CN=CREEVE.QU=EMPLOYEES.O... CHN=Charles Reeve, OlU=Employe... = Successfully queued event.
" CN=DSTANWYCK.OU=EMPLOYEE... CMN=David Stanwyck, OU=Emplo... Successfully qgueued event.
" CN=FWCOLWORTH.OU=EMPLO... CMN=Francis Woolworth,OU=Em... = Successfully queued event.
4" CN=GEASTMAMN.OU=EMPLOYEES... CM=George Eastman,OU=Emplo.. Successfully queued event,
" CN=JHOWE.QU=EMPLOYEES.O... CN=Julia Howe,OU=Employess,... = Successfully queued event.
4" CN=JJORDOMN.OU=EMPLOYEES.... = CMN=Jeffrey Jordon,OU=Employe... Successfully queued event,
4" CN=KMERMAN OU=EMPLOVEES.... CM=Karen Merman,OU=Employ... Successfully queued event,
" CN=LBALLOU=EMPLOYEES.OU=... CMN=Lauren Ball, 0U=Employess,... Successfully qgueued event,
" CN=MCOMBS OU=EMPLOYEES.... = CMN=Mark Combs,OU=Employes... = Successfully queued event,
4" CN=MLANGELLA. OU=EMPLOYEE... CM=Mary Langella,OU=Employe... Successfully queued event,
" CN=FPTIFFANY.QU=EMPLOYEES.... CN=Paul Tiffany, OU=Employess,... = Successfully queued event.
" CN=RWHITMAN.OU=EMPLOYEE... = CWN=Ronald Whitman,OU=Empl... | Successfully queued event,
4" CN=SWHARTON.OU=EMPLOYEE... CM=>35ally Wharton,OQU=Employe... Successfully queued event,
" CN=TROCKWELL OU=EMPLOYEE... ~CMN=Tim Rockwell, OU=Employes... = Successfully queued event,
" CN=WIRVING,OU=EMPLOYEES.... CHN=Wallace Irving, OU=Employe... = Successfully queued event.

Finish

23 Click Finish to close the Data Migration Wizard.

1.9 Performing a Folder to User Data Migration

1 Make sure you have completed the prerequisites and have created a migration proxy account.
For more information on the prerequisites, see Section 1.3, “Prerequisites,” on page 11. For
more information on creating a migration proxy account, see Section 1.4, “Creating the Migration
Proxy Account,” on page 13.

In the Admin Client, click the Cross-Empire Data Migration tab.
Click eDirectory to Active Directory.
4 Select Migration Wizards > Data and Security.
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Cross-Empire Data Migration Wizard - Data and Security X

Migraticn Type

Select Migration Type Options
Migration Type
Select from the following types of migrations:
User to User - maps source and target based on the selected folder type for users.

Folder to User - maps folders from the source tree to the selected folder type for users in the target
tree

Group to Group - maps source and target based on the home folder for selected groups
Folder to Group - maps folders from the source tree to the home folder for groups in the target tree
Folder to Folder - maps folders from the source tree to a folder in the target tree

Path Type
Select the path type for migration. Selection choices only apply to user folder migrations.

4 | 3
Migration Type Options

Migration Type

Path Type -

Cancel

5 From the Migration Type drop-down menu, select Folder to User.

6 From the Path Type drop-down menu, select the target path type for the data that you will
migrate.

For example, if you select Home Folder, the data is copied to each user's home folder path as
defined in directory services.

7 Click Next.
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Cross-Empire Data Migration Wizard - Data and Security X

Folder to User

Define Automatic Mappings

Generate Automatic Mappings
Select this option to create auto-generated mappings between selected source and target objects
and folders. Object matching is based on the folder name, or on the object name. Object names
are derived from the Common MName (CN) for eDirectory and from the SAM Account Name for
Active Directory.

Depending on the Migration Type previously selected, the mappings are built as follows:

Userto User/ Group to Group - select parent containers to automatically match source
objects to target objects based on object name.
For eDirectory, name is based on Common Mame or CH.
For Active Directory, the name is based on the SAM Account Name.

Folder to User / Folderto Group - select a parent source folder and a parent target container.
Folder names from the source parent path are matched to object names in the selected
target container.

Folder to Folder - select a source parent folder and a target parent folder. Folder names from
the source parent path are matched to folder names in the selected target parent path.

Generate Automatic Mappings (Optional)

0 Click Mext to skip Automatic Mappings and continue with custom mappings.

Cancel

8 Do one of the following:

+ Fill in the following fields:

Generate Automatic Mappings (Optional): If you are migrating a large number of folders,
select this check box to activate the other fields.

Source Folder: Specify an initial UNC path for a server and volume to browse.
For example, \\ server _nane\ vol une_nane\ or\\i p_address\vol une_nane\
Target Container: Browse to select the target container.

Include source items not having a matching target: Indicate if you want to identify
source data not having a matching target.

+ If you are migrating only a few users, use the Add button on the next wizard page to add the
users individually.

9 Click Next.

The Data Migration Wizard attempts to match the names of the subfolders of the source path
with the SAM (Security Accounts Manager) Account Names in the Active Directory target. If
there is a match, the listed folder in the Source Folder field is selected and a corresponding
match is listed in the Target Object column.
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1"

12
13

14

Cross-Empire Data Migration Wizard - Data and Security

Folder to User

Define Mappings

o= Add == Remove = Edit

Source Folder

woes11fms\nyoval WUSERS\BCAG...
Woes11fmsnyorol TVUSERS\BLOM...
“Woes11fms\nyovol T\USERS\BSTRE...
Woes11fmswnyoval WUSERSVCREEVE
‘woes11fms\nyovol WUSERS\DSTA...
Woes11fmsnyorol TNUSERS\VFWO...

‘Wwoes11fms\nyovol 1WUSERSJHOWE
‘Woes11fmsnyovol TWUSERSWKMER...
Woes11fmsinyorol TWUSERSVLBALL
Woes11fms\nyovol 1WUSERSWMCO..,

‘Woes11fms\nyovol TNUSERS\MLAM...

Woes11fms\nyovol WUSERSWRWHLL..

<[] T =T T[] T T [T T T [T | T =] [T [ T T&] [

YWoes11fmsinyovol TWUSERS\TROC...
1 Wwoes11fmsinvovol TWUSERSYWIRV ...

Woesl1fms\nyovol1WJSERSWARCO..,

‘Woes11fms\nyovol TWUSERSVGEAST...

Woesl1fms\nyovol1WJSERSWUIORD..,

‘Woes11fmsinyovol 1WUSERS\PTIFFA...

‘Woes11fms\nyovol TWUSERS\SWHA...

Select= [ Deselect ~

Target Object

Alice Rooney.Employess NYC.DYN...
Ben Cagney.Employess NYC DYMNA..,
BEret Lombardi.Employess. NYC.DY...
Brenda Streisand.Employess.NYC....
Charles Reeve.Employess.NYC.DY...
David Stanwyck. Employess.NYC.D...
Francis Woolworth.Employess.MY...
George Eastman.Employess.NYC....
Julia Howe Employess.NYC,DYMA...
Jeffrey Jordon.Employess. MYC.DY...
Karen Merman.Employess.NYC.DY...
Lauren Ball.Employess MYC.DYMNA..,
Mark Combs.Employess. NYC.DYM...
Mary Langella.Employess.NYC.DY...
Paul Tiffany.Employess NYC.DYNA..,
Ronald Whitman.Employess.NYC....
Sally Wharton.Employess. NYC.DY...
Tim Rockwell.Employess. NYC.DYN...

Wallace Ivina.Emplovess. MYC.DY...
Auto Map Count: 20 Total: 20 Selected: 20

¥ Lload [ Save

Target SAM
arooney
bragney
blombardi
bstreisand
cregve
dstanwyck
fwoolworth
geastman
jhowe
jiordon
kmerman
Iball
mcombs
mlangella
ptiffany
rwhitman
swharton
trockwell

wirving

MNext =

Specify a target object for each source object that is not automatically matched by double-

clicking the name to bring up the Modify Data Map Entry dialog box.

Click Browse, specify the target object, then click OK.

The target object is displayed in the Target Object column.

Click the check box corresponding to the listing with the new target.

Repeat Step 10 and Step 11 to specify all target objects that are not listed.

To change the specified target object, use the Edit button.

To add an object to the Source Object column, use the Add button.

When all of the objects you want to migrate are selected and have an associated target object,

click Next.
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Cross-Empire Data Migration Wizard - Data and Security X

Folder to User

Data Copy Options
Policy Options

+' | Require use of Policies for target objects

Owverwrite Options

Mever Overwrite -

Directory Quota

Cio Mot Apply Source Directory Quota -

Target Subfolder

Use Subfolder

Cancel

15 Fill in the following fields:

Require use of Policies for target objects: If you are migrating data for objects to an Active
Directory container that has an associated File Dynamics policy, leave this check box selected.

If this check box is selected and there is no associated File Dynamics policy, the object’s data is
not eligible for migration.

Additionally, if you are migrating a folder and the target user is not currently managed by an
associated policy, but the user does have a policy that would apply to it, File Dynamics
automatically applies that policy to the target user.

If you are migrating folders to an Active Directory container that does not have an associated File
Dynamics policy, deselect this check box.

Overwrite Options: Indicate what you want to take place when duplicate filenames are
encountered in the source and target.

Directory Quota: Specify how quota settings from the source Novell or Micro Focus file system
should be applied after the migration.

Target Subfolder: If you want migrated data to be placed in a subfolder, select the Use
subfolder check box and specify the subfolder name in the field.
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16 Click Next.

Cross-Empire Data Migration Wizard - Data and Security x

Folder to User

Rights and Ownership Copy Options
Ownership
Owner for Target Folder

Use Policy-Defined Path Owner - Browse

Cwerride policy owner setting
Owner for Target Folder Contents
Set to Target Object - Erowse
Override policy owner setting
Identity Map
Use |dentity Map ﬂldentity Map Entry Count: &4 |dentity Map

Cancel

17 Fill in the following fields:

Owner for Target Folder: Use these settings to specify how ownership of the migrated folder is
determined.
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If you selected the Require use of Policies for target objects check box in the previous wizard
page, only the Use Policy-Defined Path Owner and Set Explicit Owner options are available on
the drop-down menu.

+ Use Operating System Defaults: This default setting allows the target Microsoft Windows
Server to adjust the file ownership according to the settings on the target server.

+ Set to Target Object: Specifies the target object as the owner of the migrated files. If the
policy specifies a different owner, the policy’s owner is applied.

+ Use Policy-Defined Path Owner: Ownership of the files is determined according to the
settings in the File Dynamics policy associated with the container where the object is
managed.

+ Set Explicit Owner: Allows you to browse and select an object as the explicit owner of the
migrated folder, unless the policy specifies another object as the owner. To override the
policy’s configuration, select the Override policy owner setting check box.

Owner for Target Folder Contents: Use these settings to specify how ownership of the
migrated folder contents is determined.

If you selected the Require use of Policies for target objects check box in the previous wizard
page, only the Set to Target Object, and Set Explicit Owner options are available on the drop-
down menu.

+ Use Operating System Defaults: This default setting allows the target Microsoft Windows
Server to adjust the file ownership according to the settings on the target server.

+ Set to Target Object: Specifies the target object as the owner of the migrated files. If the
policy specifies a different owner, the policy’s owner is applied.

+ Set Explicit Owner: Allows you to browse and select an object as the explicit owner of the
migrated folder, unless the policy specifies another object as the owner. To override the
policy’s configuration, select the Override policy owner setting check box.

Use the Identity Map: Selecting this check box indicates that you want File Dynamics to utilize
the identity map you created earlier and use the corresponding IDs to copy security rights and
file ownership from the Novell or Micro Focus network file system to the Windows network file
system.

+ Transfer Rights and Ownership: Selecting this option indicates that you want to transfer
the file and folder security rights along with the ownership settings.

Be aware that when you transfer the ownership of a file or folder in a Windows network, you
are granting the owner Full Rights, which you might not want to provide.

+ Transfer Rights Only: Selecting this option indicates that you want to transfer only the file
and folder security rights.

+ Overwrite Trustees: Selecting this option indicates that you want any existing trustee
assignments for a target file or folder, to be overridden by the established eDirectory trustee
assignments for those files and folders.

+ Merge Trustees: Selecting this option indicates that you want the established eDirectory
trustee assignments merged with those of the target files or folders in the Windows network
file system.

Identity Map: Clicking this button opens your identity map where you can make any desired
changes.

18 Click Next.

19 (Conditional) If you want to use a filter to include or exclude specific files, select the Use Copy
Filter check box and click the Add button.

19a Fill in the following fields:
Description: Specify a description of the filter.
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Action: From the drop-down menu, select either Migrate or Ignore, based on whether the
filter specifies to migrate files or folders or to ignore them.

Files, Folders: Specify if the filter applies to files or folders.

Masks: List the file types to migrate or ignore.

19b Specify any additional filter criteria in the menus and fields that remain.

For a detailed explanation of this region of the dialog box, see Setting Vault Rules in the

Micro Focus File Dynamics 6.5 Administration Guide.

19c Click OK

20 Click Validate.

Validate shows the result of certain checks that can be run prior to the migration. The Result
column shows the status of the validation checks. If errors are displayed, you can choose to
correct those errors prior to running the migration.

Cross-Empire Data Migration Wizard - Data and Security

<[] =] [ T T ] T T [T T (T [T T (T [ T [ =
LA L L L4 L L4 LS L[ &

Select All

Folder to User

Validate Migration

Validation Results

(] Deselect All
Source

WYoes11fmsinyovol 1WUSERSVA...
‘Wwoes11fms\nyovol WUSERS\E...
‘Woes11fms\nyovol T\USERS\B...
‘Wwoes11fmsinyovol 1WUSERSAB...
‘Wwoes11fms\nyovol WUSERS\C...

Woes11fms\nyovol T\USERS\D...

YWwoes1ifmsinyovol TWUSERSVF...

‘Wwoes11fmsinyovol TWUSERS\G. ..

Woes11fms\nyoval 1WISERSY...

Woes11fms\nyoval 1WUSERSYL...

Woes11fms\nyovol TVUSERSK...
Woes11fmswnyovol TWUSERSAL...

‘Woes11fms\nyovol TWUSERSWM...
‘Wwoes11fmsinyovol TWUSERS\M...
Woes11fms\nyovol TVUSERSVPT..,

‘Woes11fmsnyovol TVUSERS\R...
WYoes11fmsinyovol WUSERSAS...
Woes11fms\nyovol 1WUSERSYT...

Target

CN=Alice Rooney, OU=Emplo...
CN=EBen Cagney, OU=Employ...
CMN=Bret Lombardi,OU=Empl...
CN=Brenda Streisand, OU=E...

CN=Charles Reeve OU=Empl...
CN=David Stanwyck, OU=Em...
CN=Francis Woolwaorth, OU=...
CN=George Eastman, OU=Em...
CN=Julia Howe, OU=Emplaye...
CN=leffrey Jordon, OU=Empl...
CN=Karen Merman,OU=Empl...
CM=Lauren BEall, CU=Employ...

CN=Mark Combs, OU=Emplo...
CN=Mary Langella,OU=Empl...
CN=Paul Tiffany, OU=Employ...
CN=Ronald Whitman, OU=E...

CN=S5ally Wharton, QU=Empl...
CN=Tim Rockwell, OU=Emplo...

Result

Operation successful.
Operation successful.
Operation successful,
Operation successful.
Operation successful.
Operation successful,
Operation successful.
Operation successful.
Operation successful,
Operation successful,
Operation successful.
Operation successful,
Operation successful,
Operation successful.
Operation successful,
Operation successful,
Operation successful.

Operation successful.

Validate

Migrate

Cancel

21 (Conditional) Take any necessary action in the Windows network file system target and then
validate again.

22 Click Migrate.
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A page appears with details of the data migration events that are queued for processing. To view
the status of migration events, click Events. For more information on Events, see Pending
Events in the Micro Focus File Dynamics 6.5 Administration Guide.

23 Click Finish to close the Data Migration Wizard.

110 Performing a Group to Group Data Migration

IMPORTANT: This migration option can be performed only if the source volume from which you are
migrating has group home folders being managed by Micro Focus Storage Manager for eDirectory
group-based collaborative storage policies.

1 Make sure you have completed the prerequisites and have created a migration proxy account.
For more information on the prerequisites, see Section 1.3, “Prerequisites,” on page 11. For
more information on creating a migration proxy account, see Section 1.4, “Creating the Migration
Proxy Account,” on page 13.

2 In the Admin Client, click the Cross-Empire Data Migration tab.
3 Click eDirectory to Active Directory.
4 Select Migration Wizards > Data and Security.
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Cross-Empire Data Migration Wizard - Data and Security X

Migraticn Type

Select Migration Type Options
Migration Type
Select from the following types of migrations:
User to User - maps source and target based on the selected folder type for users.

Folder to User - maps folders from the source tree to the selected folder type for users in the target
tree

Group to Group - maps source and target based on the home folder for selected groups
Folder to Group - maps folders from the source tree to the home folder for groups in the target tree
Folder to Folder - maps folders from the source tree to a folder in the target tree

Path Type
Select the path type for migration. Selection choices only apply to user folder migrations.

4 | 3
Migration Type Options

Migration Type -

Path Type -

Cancel

5 From the Migration Type drop-down menu, select Group to Group.
6 Click Next.
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Cross-Empire Data Migration Wizard - Data and Security X

Group to Group

Define Automatic Mappings

Generate Automatic Mappings
Select this option to create auto-generated mappings between selected source and target objects
and folders. Object matching is based on the folder name, or on the object name. Object names
are derived from the Common MName (CN) for eDirectory and from the SAM Account Name for
Active Directory.

Depending on the Migration Type previously selected, the mappings are built as follows:

Userto User/ Group to Group - select parent containers to automatically match source
objects to target objects based on object name.
For eDirectory, name is based on Common Mame or CH.
For Active Directory, the name is based on the SAM Account Name.

Folder to User / Folderto Group - select a parent source folder and a parent target container.
Folder names from the source parent path are matched to object names in the selected
target container.

Folder to Folder - select a source parent folder and a target parent folder. Folder names from
the source parent path are matched to folder names in the selected target parent path.

Source Container / Source Folder

Selert the snnrre narent falder ar narent container tn aearch for matrhes  Mate that anle the

Generate Automatic Mappings (Optional)

0 Click Mext to skip Automatic Mappings and continue with custom mappings.

Cancel

7 Do one of the following:
+ Fill in the following fields:

Generate Automatic Mappings: If you are migrating a large number of groups, select this
check box to activate the other fields.

Source Container: Browse to select the source container.
Target Container: Browse to select the target container.

Include source items not having a matching target: Indicate if you want to identify
source data not having a matching target.

+ If you are migrating only a few groups, use the Add button in the next wizard page to add
the groups individually.

8 Click Next.

The Data Migration Wizard attempts to match the Common Names (CN) of objects from the
eDirectory source with the SAM (Security Accounts Manager) Account Names in the Active
Directory target. If there is a match, the listed object in the Source Object field is selected and a
corresponding match is listed in the Target Object column.
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13

Cross-Empire Data Migration Wizard - Data and Security

Group to Group

Define Mappings

= Add

Source Object
Finance Dept. HQ.CORP

<

HQ Marketing. HQL.CORP

HG Quota Manager.HO.CORP
HQ Sales.HQ.CORP

HR Dept.HQ.CORP

IT Administrators. HQ.CORP
IT Helpdesk. HQL.CORP

IT Support. HQ.CORP

<[] <[« ][«

Legal Department.HO, CORP
Medical Team.HQ.CORP

<

Project Managers.HQ.CORP
Risk Management HQ.CORP

Remove Edit

Select -

[] Deselect =

Target Object

Finance Dept. Groups. HQ.DYMAML...
HQ Marketing. Groups, HQ.DYMAMI...

HQ Sales.Groups, HO.DYNAMICS. dy...
HR Dept.Groups HQ.DYNAMICS. dy...
IT Administrators.Groups. HO.DYMNA...
IT Helpdesk.Groups.HOQ,DYMAMICS...
IT Support. Groups. HO.DYNAMICS...
Legal Department. Groups. HOQ.DYM...

Project Managers.Groups, HQ.DYM...
Risk Management.Groups.HG DYM...

¥=] Load

EH save

Target SAM
Finance Dept

HQ Marketing

HQ Sales

HR Dept

IT Administrators
IT Helpdesk

IT Support

Legal Department

Project Managers
Risk Management

Training Dept. HO.CORP

Auto Map Count: 10 Total: 13 Selected: 10

Cancel

Specify a target object for each source object that is not automatically matched by double-
clicking the name to bring up the Modify Data Map Entry dialog box.

Click Browse, specify the target object, then click OK.

The target object is displayed in the Target Object column.

Click the check box corresponding to the listing with the new target.
Repeat Step 9 and Step 10 to specify all target objects that are not listed.
To change the specified target object, use the Edit button.

To add an object to the Source Object column, use the Add button.

When all of the objects you want to migrate are selected and have an associated target object,
click Next.
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Cross-Empire Data Migration Wizard - Data and Security X

Group to Group

Data Copy Options
Policy Options

+' | Require use of Policies for target objects

Owverwrite Options

Mever Overwrite -

Directory Quota

Cio Mot Apply Source Directory Quota -

Target Subfolder

Use Subfolder

Cancel

14 Fill in the following fields:

Require use of Policies for target objects: If you are migrating data for objects to an Active
Directory container that has an associated File Dynamics policy, leave this check box selected.

If this check box is selected and there is no associated File Dynamics policy, the object’s data is
not eligible for migration.

Additionally, if you are migrating a group folder and the target group is not currently managed by
an associated policy, but the object does have a policy that would apply to it, File Dynamics will
automatically apply that policy to the target object.

If you are migrating group folders to Active Directory objects that do not have policy associations,
deselect this check box.

Overwrite Options: Indicate what you want to take place when duplicate filenames are
encountered in the source and target.

Directory Quota: Specify how quota settings from the source Novell or Micro Focus file system
should be applied after the migration.

Target Subfolder: If you want migrated data to be placed in a subfolder, select the Use
subfolder check box and specify the subfolder name in the field.
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15 Click Next.

Cross-Empire Data Migration Wizard - Data and Security x

Group to Group

Rights and Ownership Copy Options
Ownership
Owner for Target Folder

Use Policy-Defined Path Owner - Browse

Cwerride policy owner setting
Owner for Target Folder Contents
Set to Target Object - Erowse
Override policy owner setting
Identity Map
Use |dentity Map ﬂldentity Map Entry Count: &4 |dentity Map

Cancel

16 Fill in the following fields:

Owner for Target Folder: Use these settings to specify how ownership of the migrated folder is
determined.
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If you selected the Require use of Policies for target objects check box in the previous wizard
page, only the Use Policy-Defined Path Owner and Set Explicit Owner options are available on
the drop-down menu.

+ Use Operating System Defaults: This default setting allows the target Microsoft Windows
Server to adjust the file ownership according to the settings on the target server.

+ Set to Target Object: Specifies the target object as the owner of the migrated files. If the
policy specifies a different owner, the policy’s owner is applied.

+ Use Policy-Defined Path Owner: Ownership of the files is determined according to the
settings in the File Dynamics policy associated with the container where the object is
managed.

+ Set Explicit Owner: Allows you to browse and select an object as the explicit owner of the
migrated folder, unless the policy specifies another object as the owner. To override the
policy’s configuration, select the Override policy owner setting check box.

Owner for Target Folder Contents: Use these settings to specify how ownership of the
migrated folder contents is determined.

If you selected the Require use of Policies for target objects check box in the previous wizard
page, only the Set to Target Object and Set Explicit Owner options are available on the drop-
down menu.

+ Use Operating System Defaults: This default setting allows the target Microsoft Windows
Server to adjust the file ownership according to the settings on the target server.

+ Set to Target Object: Specifies the target object as the owner of the migrated files. If the
policy specifies a different owner, the policy’s owner is applied.

+ Set Explicit Owner: Allows you to browse and select an object as the explicit owner of all
of the migrated files, unless the policy specifies another object as the owner. To override the
policy’s configuration, select the Override policy owner setting check box.

Use the Identity Map: Selecting this check box indicates that you want File Dynamics to utilize
the identity map you created earlier and use the corresponding IDs to copy security rights and
file ownership from the Novell or Micro Focus network file system to the Windows network file
system.

+ Transfer Rights and Ownership: Selecting this option indicates that you want to transfer
the file and folder security rights along with the ownership settings.

Be aware that when you transfer the ownership of a file or folder in a Windows network, you
are granting the owner Full Rights, which you might not want to provide.

+ Transfer Rights Only: Selecting this option indicates that you want to transfer only the file
and folder security rights.

+ Overwrite Trustees: Selecting this option indicates that you want any existing trustee
assignments for a target file or folder to be overridden by the established eDirectory trustee
assignments for those files and folders.

+ Merge Trustees: Selecting this option indicates that you want the established eDirectory
trustee assignments merged with those of the target files or folders in the Windows network
file system.

Identity Map: Clicking this button opens your identity map where you can make any desired
changes.

17 Click Next.

18 (Conditional) If you want to use a filter to include or exclude specific files, select the Use Copy
Filter check box and click the Add button.

18a Fill in the following fields:
Description: Specify a description of the filter.
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Action: From the drop-down menu, select either Migrate or Ignore, based on whether the
filter specifies to migrate files or folders or to ignore them.

Files, Folders: Specify if the filter applies to files or folders.

Masks: List the file types to migrate or ignore.

18b

Specify any additional filter criteria in the menus and fields that remain.

For a detailed explanation of this region of the dialog box, see Setting Vault Rules in the

Micro Focus File Dynamics 6.5 Administration Guide.

18c Click OK.
19 Click Validate.

Validate shows the result of certain checks that can be run prior to the migration. The Result
column shows the status of the validation checks. If errors are displayed, you can choose to
correct those errors prior to running the migration.

Cross-Empire Data Migration Wizard - Data and Security

ooQoQoCceee

Select All

Group to Group

Validate Migration

Validation Results

(] Deselect All

Source

CN=Finance Dept.OU=HO.O=...

CM=HQ Marketing. OU=HQ.0...
CN=HQ 5ales.OU=HQ.O=CORP
CM=HR Dept.OU=HQ.0=CORP
CM=IT Administrators.OU=HC...
CN=IT Helpdesk.OU=HQ.O=C...
CN=IT Support.OU=HQ.0=C...

CM=Legal Department.OU=H...
CM=Project Managers. OlU=H...

CM=Risk Management.OU=H...

Target

CN=Finance Dept, OU=Group...
CM=HQ Marketing, OU=Grou...

CM=HQ Sales, OU=Groups, OU...
CMN=HR Dept, OU=Groups,OU...
CM=IT Administrators, OU=0Gr...

CM=IT Helpdesk, OU=Groups,...

CN=IT Support, OU=Graups, ...
CM=Legal Department, OU=Gr...
CM=Project Managers, OU=0Gr...
CM=Risk Management, OU=Gr...

Result

Source object has no home directory defi...
Source object has no home directory defi...
Source object has no home directory defi...
Source object has no home directory defi...
Source object has no home directory defi...
Source object has no home directory defi...
Source object has no home directory defi...
Source object has no home directory defi...
Source object has no home directory defi...

Source object has no home directory defi...

Validate

Migrate

Cancel

20 (Conditional) Take any necessary action in the Windows network file system target and then
validate again.

21 Click Migrate.
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A page appears with details of the data migration events that are queued for processing. To view
the status of migration events, click Events. For more information on Events, see Pending
Events in the Micro Focus File Dynamics 6.5 Administration Guide.

22 Click Finish to close the Data Migration Wizard.

111 Performing a Folder to Group Migration

1 Make sure you have completed the prerequisites and have created a migration proxy account.
For more information on the prerequisites, see Section 1.3, “Prerequisites,” on page 11. For
more information on creating a migration proxy account, see Section 1.4, “Creating the Migration
Proxy Account,” on page 13.

2 In the Admin Client, click the Cross-Empire Data Migration tab.
3 Click eDirectory to Active Directory.
4 Select Migration Wizards > Data and Security.

Cross-Empire Data Migration Wizard - Data and Security X

Migraticn Type

Select Migration Type Options
Migration Type
Select from the following types of migrations:
User to User - maps source and target based on the selected folder type for users.

Folder to User - maps folders from the source tree to the selected folder type for users in the target
tree

Group to Group - maps source and target based on the home folder for selected groups
Folder to Group - maps folders from the source tree to the home folder for groups in the target tree
Folder to Folder - maps folders from the source tree to a folder in the target tree

Path Type
Select the path type for migration. Selection choices only apply to user folder migrations.

4 | 3
Migration Type Options

Migration Type -

Path Type -

5 From the Migration Type drop-down menu, select Folder to Group.
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6 Click Next.

Cross-Empire Data Migration Wizard - Data and Security x

Folder to Group

Define Automatic Mappings

Generate Automatic Mappings
Select this option to create auto-generated mappings between selected source and target objects
and folders. Object matching is based on the folder name, or on the object name. Object names
are derived from the Common Mame (CN) for eDirectory and from the SAM Account Name for
Active Directory.

Depending on the Migration Type previously selected, the mappings are built as follows:

Userto User/ Group to Group - select parent containers to automatically match source
objects to target objects based on object name.
For eDirectory, name is based on Common Mame or CN.
For Active Directory, the name is based on the SAM Account Mame.

Folder to User / Folderto Group - select a parent source folder and a parent target container.
Folder names from the source parent path are matched to object names in the selected
target container.

Folder to Folder - select a source parent folder and a target parent folder. Folder names from
the source parent path are matched to folder names in the selected target parent path.

Generate Automatic Mappings [Optional)

o Click Mext to skip Automatic Mappings and continue with custom mappings.

Cancel

7 Do one of the following:
¢ Fill in the following fields:

Generate Automatic Mappings: If you are migrating a large number of folders, select this
check box to activate the other fields.

Source Folder: Specify an initial UNC path for a server and volume to browse.

For example \\ server _nane\ vol une_nane\ or\\i p_address\ vol une_nane\

After a path is entered, you can click the Browse button to browse to the folder you want.
Target Container: Browse to select the target container.

Include source items not having a matching target: Indicate if you want to identify
source data not having a matching target object.

+ If you are migrating only a few users, use the Add button on the next wizard page to add the
users individually.

8 Click Next.
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The Data Migration Wizard attempts to match the names of subfolders of the source path with
the SAM (Security Accounts Manager) Account Names in the Active Directory target. If there is a
match, the listed folder in the Source Folder field is selected and a corresponding match is listed
in the Target Object column.

Cross-Empire Data Migration Wizard - Data and Security x

Folder to Group

Define Mappings

== Add Remove Select~ [ | Deselect~ | 5| Load

A save

Source Folder
| Woes11fms\hgvol \TRAIMINGWCRM Training
| WioesT1fms\hgvol 1" TRAIMIMGYMS Excel 2016

Target Object
CRM Training.Courses. Traini...

MS Excel 2016.Courses. Traini...

Target SAM
CRM Training
MS Excel 2016

Auto Map Count: 2 Total 2 Selected: 2

Mext >

Specify a target object for each source folder that is not automatically matched by double-
clicking the name to bring up the Modify Data Map Entry dialog box.

Click Browse, specify the target object, then click OK.

The target object is displayed in the Target Object column.

Click the check box corresponding to the listing with the new target.
Repeat Step 9 and Step 10 to specify all target objects that are not listed.
To change the specified target object, use the Edit button.

To add an object to the Source Object column, use the Add button.

When all of the objects you want to migrate are selected and have an associated target object,
click Next.
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Cross-Empire Data Migration Wizard - Data and Security X

Folder to Group

Data Copy Options
Policy Options

+' | Require use of Policies for target objects

Owverwrite Options

Mever Overwrite -

Directory Quota

Cio Mot Apply Source Directory Quota -

Target Subfolder

Use Subfolder

Cancel

14 Fill in the following fields:

Require use of Policies for target objects: If you are migrating data for objects to an Active
Directory container that has an associated File Dynamics policy, leave this check box selected.

If this check box is selected and there is no associated File Dynamics policy, the object’s data is
not eligible for migration.

Additionally, if you are migrating a folder and the target group is not currently managed by an
associated policy, but the group does have a policy that would apply to it, File Dynamics
automatically applies that policy to the target group.

If you are migrating folder data to Active Directory objects that do not have policy associations,
deselect this check box.

Overwrite Options: Indicate what you want to take place when duplicate filenames are
encountered in the source and target.

Directory Quota: Specify how quota settings from the source Novell or Micro Focus file system
should be applied after the migration.

Target Subfolder: If you want migrated data to be placed in a subfolder, select the Use
subfolder check box and specify the subfolder name in the field.
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15 Click Next.

Cross-Empire Data Migration Wizard - Data and Security x

Folder to Group

Rights and Ownership Copy Options
Ownership
Owner for Target Folder

Use Policy-Defined Path Owner - Browse

Cwerride policy owner setting
Owner for Target Folder Contents
Set to Target Object - Erowse
Override policy owner setting
Identity Map
Use |dentity Map ﬂldentity Map Entry Count: &4 |dentity Map

Cancel

16 Fill in the following fields:

Owner for Target Folder: Use these settings to specify how ownership of the migrated folder is
determined.
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If you selected the Require use of Policies for target objects check box in the previous wizard
page, only the Use Policy-Defined Path Owner and Set Explicit Owner options are available on
the drop-down menu.

+ Use Operating System Defaults: This default setting allows the target Microsoft Windows
Server to adjust the file ownership according to the settings on the target server.

+ Set to Target Object: Specifies the target object as the owner of the migrated files. If the
policy specifies a different owner, the policy’s owner is applied.

+ Use Policy-Defined Path Owner: Ownership of the files is determined according to the
settings in the File Dynamics policy associated with the container where the object is
managed.

+ Set Explicit Owner: Allows you to browse and select an object as the explicit owner of the
migrated folder, unless the policy specifies another object as the owner. To override the
policy’s configuration, select the Override policy owner setting check box.

Owner for Target Folder Contents: Use these settings to specify how ownership of the
migrated folder contents is determined.

If you selected the Require use of Policies for target objects check box in the previous wizard
page, only the Set to Target Object and Set Explicit Owner options are available on the drop-
down menu.

+ Use Operating System Defaults: This default setting allows the target Microsoft Windows
Server to adjust the file ownership according to the settings on the target server.

+ Set to Target Object: Specifies the target object as the owner of the migrated files. If the
policy specifies a different owner, the policy’s owner is applied.

+ Set Explicit Owner: Allows you to browse and select an object as the explicit owner of the
migrated files, unless the policy specifies another object as the owner. To override the
policy’s configuration, select the Override policy owner setting check box.

Use the Identity Map: Selecting this check box indicates that you want File Dynamics to utilize
the identity map you created earlier and use the corresponding IDs to copy security rights and
file ownership from the Novell or Micro Focus network file system to the Windows network file
system.

+ Transfer Rights and Ownership: Selecting this option indicates that you want to transfer
the file and folder security rights along with the ownership settings.

Be aware that when you transfer the ownership of a file or folder in a Windows network, you
are granting the owner Full Rights, which you might not want to provide.

+ Transfer Rights Only: Selecting this option indicates that you want to transfer only the file
and folder security rights.

+ Overwrite Trustees: Selecting this option indicates that you want any existing trustee
assignments for a target file or folder to be overridden by the established eDirectory trustee
assignments for those files and folders.

+ Merge Trustees: Selecting this option indicates that you want the established eDirectory
trustee assignments merged with those of the target files or folders in the Windows network
file system.

Identity Map: Clicking this button opens your identity map where you can make any desired
changes.

Click Next.

(Conditional) If you want to use a filter to include or exclude specific files, select the Use Copy
Filter check box and click the Add button.

18a Fill in the following fields:
Description: Specify a description of the filter.
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Action: From the drop-down menu, select either Migrate or Ignore, based on whether the
filter specifies to migrate files or folders or to ignore them.

Files, Folders: Specify if the filter applies to files or folders.
Masks: List the file types to migrate or ignore.
18b Specify any additional filter criteria in the menus and fields that remain.

For a detailed explanation of this region of the dialog box, see Setting Vault Rules in the
Micro Focus File Dynamics 6.5 Administration Guide.

18c Click OK.
19 Click Validate.

Validate shows the result of certain checks that can be run prior to the migration. The Result
column shows the status of the validation checks. If errors are displayed, you can choose to
correct those errors prior to running the migration.

Cross-Empire Data Migration Wizard - Data and Security

Folder to Group

Validate Migration
Validation Results

Select Al [] Deselect All

Source Target Result

ﬂ Woes11fmsthquol TRAIMINGY... CHM=CRM Training,OU=Cours...  No action taken due to pending events fo...
o WoesT1fms\hgvol N TRAIMING... | CHN=M5 Excel 2016,0U=Cours... Mo action taken due to pending events fo...

Validate Migrate

20 (Conditional) Take any necessary action in the Windows network file system target and then
validate again.

21 Click Migrate.
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A page appears with details of the data migration events that are queued for processing. To view
the status of migration events, click Events. For more information on Events, see Pending
Events in the Micro Focus File Dynamics 6.5 Administration Guide.

22 Click Finish to close the Data Migration Wizard.

112 Performing a Folder to Folder Migration

1.121

A folder to folder migration has flexible target specification options that are not available in the other
migration options. When you perform a folder to folder migration, you can either specify an existing
target folder or create a target folder in the Data Migration Wizard. You can also decide whether to
migrate all of the files at once, or skip some files and migrate them later.

The preferred time for performing a folder to folder migration is when all files located in the folders to
be migrated are closed, such as during the weekend. However, if you have large data sets to migrate,
some folder to folder migrations might need to be started during the week, when some of the files
intended for migration are open. In cases such as these, we recommend a two-phased folder to folder
migration:

Migrating Unopened Files: While users are still logged in, you migrate all of the unopened files in
the source location. This will be the vast majority of your network files. Because the Skip Open Files
option is selected, open files are not migrated, but the filenames and paths of all of the open files are
logged in a text file.

NOTE: If you perform a Cross-Empire Data Migration when all users are logged off, you do not need
to migrate skipped files.

Migrating Skipped, New, and Modified Files: After having all users log off or all previously open
files have been closed, migrate the skipped files, migrate the new and modified files, then compare
the files on the source and target servers to verify that everything migrated correctly.

¢ Section 1.12.1, “Determine Whether You Will Be Migrating to an Existing Target Folder or
Creating a Target Folder During the Migration,” on page 65
+ Section 1.12.2, “Migrating to an Existing Target Folder,” on page 66

+ Section 1.12.3, “Scanning the Source Server for New or Modified Directories and Files,” on
page 78

+ Section 1.12.4, “Migrating the New and Modified Directories and Files,” on page 80

+ Section 1.12.5, “Verifying that All Directories and Files were Migrated by Comparing Source
Server and Target Server Contents,” on page 84

+ Section 1.12.6, “Creating a Target Folder in the Data Migration Wizard,” on page 86

Determine Whether You Will Be Migrating to an Existing
Target Folder or Creating a Target Folder During the
Migration

You have the option of migrating data to an existing target folder on the target server, or creating the
target folder on the target server during the migration. The procedures differ for both, so at this point
you must decide and then follow the appropriate procedures.

If you are plan to migrate folder data to an existing target folder on the target server, proceed with
Section 1.12.2, “Migrating to an Existing Target Folder,” on page 66.
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If you plan to migrate folder data to a target folder that you create during the migration, proceed with
Section 1.12.6, “Creating a Target Folder in the Data Migration Wizard,” on page 86.

1.12.2 Migrating to an Existing Target Folder

+ “Migrating Unopened Files” on page 66
+ “Migrating Skipped Files” on page 74

Migrating Unopened Files

1 Make sure you have completed the prerequisites and have created a migration proxy account.

For more information on the prerequisites, see Section 1.3, “Prerequisites,” on page 11. For
more information on creating a migration proxy account, see Section 1.4, “Creating the Migration
Proxy Account,” on page 13.

2 (Conditional) If you want to migrate closed files now and skip some files to migrate later:

2a Fromthe Wi liti es\ CEDMfolder on the File Dynamics ISO image, copy the
CEDMScanConpar e. exe utility to either the Windows target server or to a Windows server
where you are going to administer the migration.

2b On each NetWare or Open Enterprise Server from which you are going to migrate data,
create a new subdirectory and name it Open.

3 In the Admin Client, click the Cross-Empire Data Migration tab.
4 Click eDirectory to Active Directory.

5 Select Migration Wizards > Data and Security.
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Cross-Empire Data Migration Wizard - Data and Security X

Migraticn Type

Select Migration Type Options
Migration Type
Select from the following types of migrations:
User to User - maps source and target based on the selected folder type for users.

Folder to User - maps folders from the source tree to the selected folder type for users in the target
tree

Group to Group - maps source and target based on the home folder for selected groups
Folder to Group - maps folders from the source tree to the home folder for groups in the target tree
Folder to Folder - maps folders from the source tree to a folder in the target tree

Path Type
Select the path type for migration. Selection choices only apply to user folder migrations.

4 | 3
Migration Type Options

Migration Type -

Path Type -

Cancel

6 From the Migration Type drop-down menu, select Folder to Folder.
7 Click Next.
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Cross-Empire Data Migration Wizard - Data and Security X

Folder to Folder

Define Automatic Mappings

Generate Automatic Mappings
Select this option to create auto-generated mappings between selected source and target objects
and folders. Object matching is based on the folder name, or on the object name. Object names
are derived from the Common MName (CN) for eDirectory and from the SAM Account Name for
Active Directory.

Depending on the Migration Type previously selected, the mappings are built as follows:

Userto User/ Group to Group - select parent containers to automatically match source
objects to target objects based on object name.
For eDirectory, name is based on Common Mame or CH.
For Active Directory, the name is based on the SAM Account Name.

Folder to User / Folderto Group - select a parent source folder and a parent target container.
Folder names from the source parent path are matched to object names in the selected
target container.

Folder to Folder - select a source parent folder and a target parent folder. Folder names from
the source parent path are matched to folder names in the selected target parent path.

Generate Automatic Mappings (Optional)

0 Click Mext to skip Automatic Mappings and continue with custom mappings.

Cancel

8 Fill in the following fields:
Generate Automatic Mappings: Select this check box to activate the other fields.
Source Folder: Specify an initial UNC path for a server and volume to browse.
For example, \\ server _nane\ vol une_nane\ or\\i p_address\ vol une_nane\
After a path is entered, you can click the Browse button to browse to the folder you want.
Target Folder: Browse to select the target folder.

Create new folder entries for items not having a matching target: Selecting this check box
indicates that you want File Dynamics to display both matching and non-matching source and
target folders.

Selecting this check box also indicates that you want File Dynamics to create and populate any
subfolders that do not exist in the target folder.

For example, assume that the source path at\\ 10. 10. 10. 233\ Vol 2\ Depart nent s is being
migrated to \ \ Cor pser ver\ Depar t nent s and the Depar t ment s directory on the source server
has a Fi nance subfolder. If there is no Fi nance subfolder in the target folder, a Fi nance
subdirectory is created to include the directory contents.

9 Click Next.
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The Data Migration Wizard attempts to match the names of the subfolders of the source path
with the subfolders of the specified target directory. If there is a match, the listed folder in the
Source Folder field is selected and a corresponding match is listed in the Target Folder column.

Cross-Empire Data Migration Wizard - Data and Security x

Folder to Folder

Define Mappings

== Add Remove Edit Select~ [ | Deselect~ | 5| Load

A save

Source Folder Target Folder

V| 4 Woes11fms\hgquol1\DEPARTMENTS\FINANCE ‘wdynamics.cctec.orgh\DFS\HO\Departments\Finance
V| 4% Woes11fms\hquol1\DEPARTMENTS\MARKETING  ‘\dynamics.cctec.org\DFS\HO\Departments\Marketing
V| 4 Woeslifms\hquol1\DEPARTMENTS\MEDICAL “dynamics.cetec.org\DFS\HO\Departments\Medical
V| 4 Yoes11fmsithquol 1\DEPARTMENTS\SALES ‘“wdynamics.cctec.orghDFS\HO\DepartmentsiSales

«" = Matching target path found
Auto Map Count: 4 Total 4 Selected: 4

Mext > Cancel

Specify a target folder for each source folder that is not automatically matched by double-clicking
the name to bring up the Modify Data Map Entry dialog box.

Click Browse, specify the target folder, then click OK.
The target folder is placed in the Target Folder column.
Click the check box corresponding to the listing with the new target.

When all of the folders you want to migrate are selected and have an associated target folder,
click Next.
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Cross-Empire Data Migration Wizard - Data and Security

Folder to Folder Using File List

Data Copy Options
Overwrite Options

Mever Overwrite

Directory Quota

Do Not Apply Source Directory Quota

Target Subfolder

Use Subfolder

Cancel

14 Fill in the following fields:

Overwrite Options: Indicate what you want to take place when duplicate filenames are

encountered in the source and target.

Directory Quota: Specify how quota settings from the source NSS file system should be applied

after the migration.

Target Subfolder: If you want migrated data to be placed in a subfolder, select the Use

subfolder check box and specify the subfolder name in the field.

Open File Options: If you want the Cross-Empire Data Migration subsystem to skip all open

files on the network and not migrate them, select Skip Open Files.

Selecting Skip Open Files activates the File List UNC Path field where you specify the name and

location of the log file listing all of the open files that are skipped during the migration.

Specify the UNC path for the Open directory you created along with a filename for the text file that

will list the skipped files.

For example, \\ server _nane\ vol une_nane\ di r ect ory_nane\ Open\ ski p. t xt

or

\\'i p_addr ess\ vol une_nane\ Open\ ski p. t xt

70 Performing an eDirectory to Active Directory Cross-Empire Data Migration




The Cross-Empire Data Migration subsystem does not validate the path, so you must make sure
that the path entered is correct. Otherwise, the migration fails.

15 Click Next.

Cross-Empire Data Migration Wizard - Data and Security x

Folder to Folder

Rights and Ownership Copy Options
Ownership
Owner for Target Folder

Use Operating System Defaults -

Owner for Target Folder Contents

Use Operating System Defaults -

ldentity Map

Use |dentity Map o Identity Map Entry Count: 64 Identity Map

Cancel

16 Fill in the following fields:

Owner for Target Folder: Use these settings to specify how ownership of the migrated folder is
determined.

+ Use Operating System Defaults: This default setting allows the target Microsoft Windows
Server to adjust the file ownership according to the setting on the target server.

+ Set Explicit Owner: Allows you to browse and select an object as the explicit owner of the
migrated folder.

Owner for Target Folder Contents: Use these settings to specify how ownership of the
migrated folder contents is determined.

+ Use Operating System Defaults: This default setting allows the target Microsoft Windows
Server to adjust the file ownership according to the settings on the target server.

+ Set Explicit Owner: Allows you to browse and select an object as the explicit owner of all
of the migrated files.
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Use the Identity Map: Select this check box if you want File Dynamics to utilize the identity map
you created earlier and use the corresponding IDs to copy security rights and file ownership from
the Novell or Micro Focus network file system to the Windows network file system.

*

Transfer Rights and Ownership: Select this option if you want to transfer the file and
folder security rights along with the ownership settings.

Be aware that when you transfer the ownership of a file or folder in a Windows network, you
are granting the owner Full Rights, which you might not want to provide.

Transfer Rights Only: Select this option to transfer only the file and folder security rights.

Overwrite Trustees: Select this option to override any existing trustee assignments for a
target file or folder with the established eDirectory trustee assignments for those files and
folders.

Merge Trustees: Select this option to merge the established eDirectory trustee
assignments with those of the target files or folders in the Windows network file system.

Identity Map: Clicking this button opens your identity map where you can make any desired
changes.

17 Click Next.

18 (Conditional) If you want to use a filter to include or exclude specific files, select the Use Copy
Filter check box and click the Add button.

18a

18b

18c

Fill in the following fields:
Description: Specify a description of the filter.

Action: From the drop-down menu, select either Migrate or Ignore, based on whether the
filter specifies to migrate files or folders or to ignore them.

Files, Folders: Specify if the filter applies to files or folders.
Masks: List the file types to migrate or ignore.
Specify any additional filter criteria in the menus and fields that remain.

For a detailed explanation of this region of the dialog box, see Setting Vault Rules in the
Micro Focus File Dynamics 6.5 Administration Guide.

Click OK.

19 Click Validate.

Validate shows the result of certain checks that can be run prior to the migration. The Result
column shows the status of the validation checks. If errors are displayed, you can choose to
correct those errors prior to running the migration.
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Cross-Empire Data Migration Wizard - Data and Security

Folder to Folder

Validate Migration
Validation Results

Select All [ | Deselect All

Source

<I[<][[<]1[~
L4 L

‘woes11fmsihgvol1\DEPARTME...
‘Wwoes11fms\hgvol1\DEPARTME...
YWwoes11fmsihgvol1\DEPARTME...
‘Wwoes11fmsihgvol1\DEPARTME...

Target

‘wdynamics. cctec.orghDFSYHO...
“Wdynamics.cctec.org\DFSW\HO..
‘idynamics, cctec.orghDFSYHON,..

‘dynamics. cctec.orgh DFSWHO...

Result

Operation successful.
Operation successful,
Operation successful.

Operation successful.

Validate

Migrate

20 (Conditional) Take any necessary action in the Windows network file system target and then

validate again.
21 Click Migrate.

A page appears with details of the data migration events that are queued for processing. To view
the status of migration events, click Events. For more information on Events, see Pending
Events in the Micro Focus File Dynamics 6.5 Administration Guide.

22 Do one of the following:

+ If you skipped some files to migrate later, click Finish and then continue with “Migrating

Skipped Files” on page 74.

+ If you have migrated all of your data, click Finish.

You are now finished with the folder to folder migration.
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Migrating Skipped Files

The second phase of a folder to folder data migration is conducted when all of the users are logged
off the network, so all network files are closed.

1 Have everyone log off the network so that there are no open files on the source NetWare or
Open Enterprise Server machines.

2 Open the text file that you created in Step 14 on page 70 and view the files that were skipped.
Do not make any changes to the file. Doing so causes errors during the migration.

3 Save a copy of the text file.
For example, if you named the file ski p. t xt , save a copy as ski p_copy. t xt.

After the Cross-Empire Data Migration subsystem migrates the skipped files, it deletes the text
file. You can use the copy to verify that the files were migrated.

4 In the Admin Client, click the Cross-Empire Data Migration tab.
5 Click eDirectory to Active Directory.

6 Select Migration Wizards > Data and Security.

Cross-Empire Data Migration Wizard - Data and Security x

Migration Type

Select Migration Type Options
Migration Type
Select from the following types of migrations:
User to User - maps source and target based on the selected folder type for users.

Folder to User - maps folders from the source tree to the selected folder type for users in the target
tree

Group to Group - maps source and target based on the home folder for selected groups
Folder to Group - maps folders from the source tree to the home folder for groups in the target tree
Folder to Folder - maps folders from the source tree to a folder in the target tree

Path Type
Select the path type for migration. Selection choices only apply to user folder migrations.

4 | 3
Migration Type Options

Migration Type -

Path Type -

i Cancel
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7 From the Migration Type drop-down menu, select Delta File.
8 Click Next.
9 Skip the Automatic Mappings settings by clicking Next.
10 On the Define Mappings wizard page, click Add.
11 In the Add Data Map Entry dialog box, browse to and select the source and target folders.

Add Data Map Entry x

Source Folder |m:es11fmsxnym|1xDEPARTMENT5 v| Browse

ﬂ For a Folder source, enter an initial UNC path such as W\WServer\Voll

Target Folder |‘ﬁdynamics.cctec.c-rg‘-.DFSRNYQNYCSharEHDEpartments |E Erowse i

oK Cancel

12 Click OK.

13 On the Define Mappings wizard page, verify the source folder and the destination folder and click
Next.
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Cross-Empire Data Migration Wizard - Data and Security

Folder to Folder Using File List

Data Copy Options
Overwrite Options

Mever Overwrite -

Directory Quota

Do Not Apply Source Directory Quota -

Target Subfolder

Use Subfolder

Folder Name MigrationData

Cancel

14 On the Data Copy Options wizard page, from the drop-down menu in the Overwrite Options
region, select Overwrite if Newer and click Next.
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a

16

17

18

19
20

Cross-Empire Data Migration Wizard - Data and Security X

Folder to Folder Using File List

Rights and Ownership Copy Options
Ownership
Owner for Target Folder

Use Operating System Defaults - Browse

Owner for Target Folder Contents

Use Operating System Defaults - Browse

Identity Map

Use Identity Map ﬂldentity Map Entry Count: 64 |dentity Map

Cancel

(Optional) On the Rights and Ownership Copy Options wizard page, from the drop-down menu
of the Owner for Target Folder region, select Set Explicit Owner.

(Conditional) If you chose to set an explicit owner for the folder, click the corresponding Browse
button and browse to specify an owner for the target folder.

(Optional) From the drop-down menu of the Owner for Target Folder Contents region, select Set
Explicit Owner.

(Conditional) if you chose to set an explicit owner for the folder contents, click the corresponding
Browse button and browse to specify an owner for the target folder contents.

Select the Use Identity Map check box and click Next.

On the Copy Filter wizard page, specify the UNC path to the file you created in Step 14 on
page 70.
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Cross-Empire Data Migration Wizard - Data and Security X

Folder to Folder Using File List

Copy Filter
File List UNC Path

@ Enter the full UNC path to the File List file
File List UNC Path

Migrate Cancel

21 Click Validate to confirm that the path is correct.
22 Click Migrate.

The skipped files are migrated and the text file that you created in Step 14 on page 70 is deleted.
23 Click Finish.

24 Continue with “Scanning the Source Server for New or Modified Directories and Files” on
page 78.

1.12.3 Scanning the Source Server for New or Modified Directories

78

and Files

Before you can migrate all of the new and modified directories and files since the first phase of the
migration, you must first generate a list of these new and modified directories and files. This is done
using the CEDMScanCompare utility.

1 Launch the CEDMScanCompare utility.
The following message appears:
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Info

scan and comparison data.

To begin, click OK to specify a working directory for this utility to use for writing

2 Click OK.

3 Click the ellipses button pertaining to the Working Directory field to browse to a folder where you
want to store the comparison data.

The CEDMScanCompare utility interface is launched.

File System Scan and Compare

File Help

File Dynamics

Source

Cantrol
Threads

1 v

Operation Working Directory

Output Fie System Data_+ | |C:UJsErs\,ﬂdm\mstIatnr.NFMS\DD(umEnls ‘

Target

Path to Scan: ‘

Path to Scan: =

Filter
/| Indude sl Fies and Folders regardless of age

Filter

| Indude files located in root directary | Indude al Files and Falders regardess of age | Indude fies located in root directary

Root Subdirectory Name Scan Filter
All

Root Subdirectory Name Scan Fifter

Include ~ List Uncheck Include ~| Al Uncheck.

Directory Name Directory Name

Scan Output Flle

FileName: |FS-scan-output.tet

Scan Qutput File

FileName: |FS-scan-output.tet

Compare / Analyze
Output Format Results
Cross-Empire Data Migration-eDir ~ Source Record Count: |:| Crly on Target: I:l
Common Path Start Points Compare Target Record Count: l:l Only on Source: I:l
targetmissing bt
Target: l:l Newer on Target: I:l Open Full Differences File

The selected folder location is specified in the Working Directory field.

In the Source region, for the Path to Scan field, browse to specify the UNC path to the directory
on the NetWare or Open Enterprise Server you want to scan.

For example: \\ oesnw\ vol 2\ dept _shares

You can scan both NetWare and OES Linux servers in your tree by using the above syntax. For
example, to scan Vol2 of an OES Linux server, you would use a syntax like the following:

\\oeslinux\vol 2

5 In the Target region, for the Path to Scan field, browse to specify the UNC path to the folder in
the target forest you want to scan.

6 In the Source region, click Scan.
7 In the Scan Result region, note the findings in the Folders and Files fields.
8 In the Target region, click Scan.
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9 In the Scan Result region, note the findings in the Folders and Files fields.

1"
12

13

14

15

16

17

In the Compare / Analyze region, from the Output Format drop-down menu, verify that Cross-
Empire Data Migration-eDir is selected.

Click Compare.
Do one of the following:

+ If the results show no discrepancies between the source and target, there are no new or
modified directories and files. You are finished with the folder to folder data migration.

+ If the results show discrepancies between the source and target, follow the remaining
procedures in this section.

Click Open Full Differences File.
A spreadsheet appears listing:

+ Allfiles on the source that are newer than the same named files on the target, along with the
source and target path of each file.

+ All files on the source that are missing from the target.

1 |Status 5_Modified  T_modified Sourcerath TargetPath

4 |NewOnTarget Fi\HOShare\Departments\Training\ Training Items needed.dad
45 | NewOnTarget F\HOShare\Departments\Training\T5 Training Agenda va.doc

Y FAHOShare\Departmants\Training\ 15 Training Agenda.docx

WWOES11FMEVHOVOLT\DEPARTMENTS\FINANCE \How Te Use Filr an An:
\W\OES11FMS\HOVOLT\DEPARTMENTS\FINANCEY
\\OES11FMS\HOVOLT\DEPARTMENTS\FINANCEY
\WOES11FMEVHOVOLI\DEPARTMENTS\FINANCEY
\WOES11FMS\HAVOLIADEPARTMENTSAFINANCE \How To Use Fils on i05 - iPhone iPad.pdl

View the files that are newer on the source server as well as those files on the source server that
were not migrated.

In the CEDMScanCompare utility interface, note the t ar get mi ssi ng. t xt output file.
This is the file listing all of the new and modified directories and files on the source server.

Locate the t ar get mi ssi ng. t xt file in the folder you specified earlier and copy the file to a
location on the source server.

Have all of your network users close any open files in the source area, and then proceed to
“Migrating the New and Modified Directories and Files” on page 80.

Migrating the New and Modified Directories and Files

Migrating all of the directories and files that are new or modified since the first phase of the folder to
folder migration follows the same process as migrating the skipped files. The only difference is that
you enter a different UNC path.

1

In the Admin Client, click the Cross-Empire Data Migration tab.

2 Click eDirectory to Active Directory.

3 Select Migration Wizards > Data and Security.
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Cross-Empire Data Migration Wizard - Data and Security

Migraticn Type

Select Migration Type Options
Migration Type
Select from the following types of migrations:
User to User - maps source and target based on the selected folder type for users.

Folder to User - maps folders from the source tree to the selected folder type for users in the target
tree

Group to Group - maps source and target based on the home folder for selected groups
Folder to Group - maps folders from the source tree to the home folder for groups in the target tree
Folder to Folder - maps folders from the source tree to a folder in the target tree

Path Type
Select the path type for migration. Selection choices only apply to user folder migrations.

4 | 3
Migration Type Options

Migration Type -

Path Type -

Cancel

4 From the Migration Type drop-down menu, select Delta File.

5 Click Next.

6 Skip the Automatic Mappings settings by clicking Next.

7 On the Define Mappings wizard page, click Add.

8 In the Add Data Entry dialog box, browse to and select the source and target folders.

Performing an eDirectory to Active Directory Cross-Empire Data Migration

81



Add Data Map Entry x

Source Folder |‘-.‘-.::nes11fms‘-.n].ro.rol1‘-.DEPARTMENT5 v| Browse

ﬂ For a Folder source, enter an initial UNC path such as V\ServeriVol1

Target Folder |‘ﬁd3rr1amics.cctec.nrg‘-.DFSENYQNYCSharE"gDEpartments | E Erowse i
oK Cancel
9 Click OK.
10 On the Define Mappings wizard page, verify the source folder and the destination folder and click
Next.

Cross-Empire Data Migration Wizard - Data and Security

Folder to Folder

Data Copy Options

Owverwrite Options

Mever Overwrite -

Directory Quota

Do Mot Apply Source Directory Quota -

Target Subfolder

Use Subfolder

Folder Name | MigrationData
Open File Options

Skip Open Files

File List UMC Path

Cancel
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11 On the Data Copy Options page, from the drop-down menu in the Overwrite Options region,

12

13

select Overwrite if Newer, then click Next.

Cross-Empire Data Migration Wizard - Data and Security

Folder to Folder Using File List

Rights and Ownership Copy Options
Ownership
Owner for Target Folder

Use Operating System Defaults -

Owner for Target Folder Contents

Use Operating System Defaults -

ldentity Map

Use Identity Map @ dentity Map Entry Count: 64

|dentity Map

Cancel

(Optional) On the Rights and Ownership Copy Options wizard page, from the drop-down menu

of the Owner for Target Folder region, select Set Explicit Owner.

(Conditional) If you chose to set an explicit owner for the folder, click the corresponding Browse

button and browse to specify an owner for the target folder.

14 (Optional) From the drop-down menu of the Owner for Target Folder Contents region, select Set

Explicit Owner.

15 (Conditional) If you chose to set an explicit owner for the folder contents, click the corresponding

16
17

Browse button and browse to specify an owner for the target folder contents.
Select the Use Identity Map check box and click Next.

On the Copy Filter wizard page, specify the UNC path to the t ar get mi ssi ng. t xt file that you

copied to the source server.
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Cross-Empire Data Migration Wizard - Data and Security X

Folder to Folder Using File List

Copy Filter
File List UNC Path

@ Enter the full UNC path to the File List file

File List UMC Path '\.'\.oes11fms'\.nycuoI1'\.migration'\.open'\.targetmissing.t:ct]

Validate Migrate Cancel

18 Click Validate to confirm that the path is correct.
19 Click Migrate.
The new and modified files are migrated.

20 Continue with Section 1.12.5, “Verifying that All Directories and Files were Migrated by
Comparing Source Server and Target Server Contents,” on page 84.

1.12.5 Verifying that All Directories and Files were Migrated by
Comparing Source Server and Target Server Contents

With all of the directories and files now migrated, you should now compare the contents of the source
server and target server to verify that everything migrated properly. The process is as follows:

1 Launch the CEDMScanCompare utility.

2 When the message appears about the need to specify a working directory for the scan and
comparison data, click OK.

3 Browse to a folder where you want to store the comparison data and click Select Folder.

84 Performing an eDirectory to Active Directory Cross-Empire Data Migration



The CEDMScanCompare utility interface is launched.

File System Scan and Compare EBE
File Help
Control
H s Threads  Operation Warkng Drrectory
File DvnaMICS 1~ Output File System Date | [C:\Users\Administrator. NFVS \Documents =
Source Target
Path to Scan: | Path to Scan: | =
Filter Fiter
/| Include al Files and Folders regardiess of age (vl Tnclude files located in root directory ] Include al Files and Folders regardless of age vl Indude fles located n root directory
Root Subdirectory Name Scan Fiter Root Subdirectory Name Scan Fitter
indude || an || ust || unchedc indude || ar || ust | [uUnchedc

Directory Name Directory Name

Sean Qutput Fie Sean Qutput File

FileName: |FS-scan-output.tct Sean FileName: |FS-scan-output.bet

Compare / Analyze
Cutput Format

Cross-Empire Data Mgration-eDir ~ Source Record Count: l:l Only on Target: |:|

Common Path Start Points Compare Target Record Count: l:l Orly on Source: I:l
targetmissing. bt

Target: I:l MNewer on Target: l:l Open Full Differences File

Results

In the Source region, for the Path to Scan field, browse to specify the UNC path to the folder
from the source server you want to scan.

In the Target region, for the Path to Scan field, browse to specify the UNC path to the folder in
the target server you want to scan.

In the Source region, click Scan.
In the Target region, click Scan.

In the Compare / Analyze region, from the FileName drop-down menu, select Cross-Empire Data
Migration-eDir.

Click Compare.
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86

File System Scan and Compare

File Help

ﬂ File Dynamics

Source

path to Scan: |OES1IFMS\HQUOL 1\DEPARTMENTS

| =

Filter
! Indude al Files and Folders regardiess of age

Sean Output File

FileName: [Scan-OFES11FMS-HQUOL1-DEPARTM Sean

Compare / Analyze
Output Format

Common Path Start Points
Source: |\\OESTIFMS\HQVOLT\DEPAK
Target: |F:\HQShare\Departments

v Indude files located in root directory
Root Subdirectory Name Scan Filter

Directory Name

Uncheck

Sean Result

e

Contral

Threads  Operation

Working Directory

[outputFie systemData v|  [R:\open | &

Targel

Path to Scan: \F: \HQshare\Departments

Filter
| Indude all Files and Folders regardiess of age

Scan Qutput File

FileName: |Scan-F-HQShare-Departments. txt

Results

Compare

Source Record Count
Target Record Count:
Match Fie Count:

Scan

o
targetmissing, bet O\
Newer on Source: I:'

| Indude files located in root directory
Root Subdirectary Name Scan Filter

Directary Name

Uncheck

Scan Result

s

Gpen Full Differences File

cleanup complete.
colision count=0
Comparison is complete

Scan Complete

10 Do one of the following:

+ |f the results show no discrepancies between the source and target, all of the folders and
files were migrated. You can close the CEDMScanCompare utility as you are now finished
with the folder to folder data migration.

+ If the results show discrepancies between the source and target, take measures to close the
open files and repeat the procedures in “Migrating the New and Modified Directories and

Files” on page 80.

Creating a Target Folder in the Data Migration Wizard

1 Make sure you have completed the prerequisites and have created a migration proxy account.

For more information on the prerequisites, see Section 1.3, “Prerequisites,” on page 11. For

more information on creating a migration proxy account, see Section 1.4, “Creating the Migration

Proxy Account,” on page 13.
2 (Conditional) If you want to migrate closed files now and skip some files to migrate later:

2a Fromthe Wi liti es\ CEDMfolder on the File Dynamics ISO image, copy the
CEDMBcanConpar e. exe utility to either the Windows target server or to a Windows server

where you are going to administer the migration.

2b On each NetWare or Open Enterprise Server from which you are going to migrate data,
create a new subdirectory and name it Open.

3 In the Admin Client, click the Cross-Empire Data Migration tab.

4 Click eDirectory to Active Directory.
5 Select Migration Wizards > Data and Security.
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Cross-Empire Data Migration Wizard - Data and Security X

Migraticn Type

Select Migration Type Options
Migration Type
Select from the following types of migrations:
User to User - maps source and target based on the selected folder type for users.

Folder to User - maps folders from the source tree to the selected folder type for users in the target
tree

Group to Group - maps source and target based on the home folder for selected groups
Folder to Group - maps folders from the source tree to the home folder for groups in the target tree
Folder to Folder - maps folders from the source tree to a folder in the target tree

Path Type
Select the path type for migration. Selection choices only apply to user folder migrations.

4 | 3
Migration Type Options

Migration Type -

Path Type -

Cancel

6 From the Migration Type drop-down menu, select Folder to Folder.
7 Click Next.

Performing an eDirectory to Active Directory Cross-Empire Data Migration 87



88

Cross-Empire Data Migration Wizard - Data and Security

Folder to Folder

Define Automatic Mappings

Generate Automatic Mappings
Select this option to create auto-generated mappings between selected source and target objects
and folders. Object matching is based on the folder name, or on the object name. Object names

are derived from the Common MName (CN) for eDirectory and from the SAM Account Name for
Active Directory.

Depending on the Migration Type previously selected, the mappings are built as follows:

Userto User/ Group to Group - select parent containers to automatically match source
objects to target objects based on object name.
For eDirectory, name is based on Common Mame or CH.
For Active Directory, the name is based on the SAM Account Name.

Folder to User / Folderto Group - select a parent source folder and a parent target container.
Folder names from the source parent path are matched to object names in the selected
target container.

Folder to Folder - select a source parent folder and a target parent folder. Folder names from
the source parent path are matched to folder names in the selected target parent path.

Generate Automatic Mappings (Optional)

m
!

[
m
T

o Click Mext to skip Automatic Mappings and continue with custom mappings.

Cancel
8 Click Next.
9 Click Add.
Add Data Map Entry x
Source Folder | v| Browse
ﬂ For a Folder source, enter an initial UNC path such as V\ServeriVol1
Target Folder | | | EBrowse
oK Cancel

10 In the Source Folder field, specify an initial UNC path for a server and volume to browse.
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For example, \\ server _nane\ vol une_narne\ or\\i p_address\vol une_nare.
After a path is entered, you can click the Browse button to browse to the folder you want.

11 Click the Browse button that corresponds to the Target Folder field to locate the share where
you want to create the new folder for the migrated data.

12 Right-click the share, select Create Folder, name the new folder, and click OK.
13 Click OK to close the Target File System Path Browser.

14 In the Add Data Map Entry dialog box, click the Browse button that corresponds to the Target
Folder field again, browse to and select the new folder, then click OK.

Add Data Map Entry X

Source Folder |‘¢-.::|E511fms‘gnynrc|I11DEPARTI".-1ENT5‘-.5uppnrt v| Erowse

ﬂ For a Folder source, enter an initial UNC path such as \\5erver\Vol1

Target Folder |‘ﬁdynamics.cctec.nrg‘-.DFSENYQNYCSharE"gDEpartments‘-.Suppnrt|| Erowse

oK Cancel

15 Click OK.
The defined source and target mappings are displayed.
16 Click Next.
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Cross-Empire Data Migration Wizard - Data and Security

Folder to Folder Using File List

Data Copy Options
Overwrite Options

Mever Overwrite

Directory Quota

Do Not Apply Source Directory Quota

Target Subfolder

Use Subfolder

Cancel

17 Fill in the following fields:

Overwrite Options: Indicate what you want to take place when duplicate filenames are

encountered in the source and target.

Directory Quota: Specify how quota settings from the source NSS file system should be applied

after the migration.

Target Subfolder: If you want migrated data to be placed in a subfolder, select the Use

subfolder check box and specify the subfolder name in the field.

Open File Options: If you want the Cross-Empire Data Migration subsystem to skip all open

files on the network and not migrate them, select Skip Open Files.

Selecting Skip Open Files activates the File List UNC Path field where you specify the name and

location of the log file listing all of the open files that are skipped during the migration.

Specify the UNC path for the Open directory you created along with a filename for the text file

that will list the skipped files.

For example, \\ server _nane\ vol une_nane\ di r ect ory_nane\ Open\ ski p. t xt

or

\\'i p_addr ess\ vol une_nane\ Open\ ski p. t xt
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The Cross-Empire Data Migration subsystem does not validate the path, so you must make sure
that the path entered is correct. Otherwise, the migration fails.

18 Click Next.

Cross-Empire Data Migration Wizard - Data and Security x

Folder to Folder

Rights and Ownership Copy Options
Ownership
Owner for Target Folder

Use Operating System Defaults -

Owner for Target Folder Contents

Use Operating System Defaults -

ldentity Map

Use |dentity Map o Identity Map Entry Count: 64 Identity Map

Cancel

19 Fill in the following fields:

Owner for Target Folder: Use these settings to specify how ownership of the migrated folder is
determined.

+ Use Operating System Defaults: This default setting allows the target Microsoft Windows
Server to adjust the file ownership according to the setting on the target server.

+ Set Explicit Owner: Allows you to browse and select an object as the explicit owner of the
migrated folder.

Owner for Target Folder Contents: Use these settings to specify how ownership of the
migrated folder contents is determined.

+ Use Operating System Defaults: This default setting allows the target Microsoft Windows
Server to adjust the file ownership according to the settings on the target server.

+ Set Explicit Owner: Allows you to browse and select an object as the explicit owner of the
migrated folder.
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Use the Identity Map: Select this check box if you want File Dynamics to utilize the identity map
you created earlier and use the corresponding IDs to copy security rights and file ownership from
the Novell or Micro Focus network file system to the Windows network file system.

*

Transfer Rights and Ownership: Select this option if you want to transfer the file and
folder security rights along with the ownership settings.

Be aware that when you transfer the ownership of a file or folder in a Windows network, you
are granting the owner Full Rights, which you might not want to provide.

Transfer Rights Only: Select this option to transfer only the file and folder security rights.

Overwrite Trustees: Select this option to override any existing trustee assignments for a
target file or folder with the established eDirectory trustee assignments for those files and
folders.

Merge Trustees: Select this option to merge the established eDirectory trustee
assignments with those of the target files or folders in the Windows network file system.

Identity Map: Clicking this button opens your identity map where you can make any desired
changes.

20 Click Next.

21 (Conditional) If you want to use a filter to include or exclude specific files, select the Use Copy
Filter check box and click the Add button.

21a

21b

21c

Fill in the following fields:
Description: Specify a description of the filter.

Action: From the drop-down menu, select either Migrate or Ignore, based on whether the
filter specifies to migrate files or folders or to ignore them.

Files, Folders: Specify if the filter applies to files or folders.
Masks: List the file types to migrate or ignore.
Specify any additional filter criteria in the menus and fields that remain.

For a detailed explanation of this region of the dialog box, see Setting Vault Rules in the
Micro Focus File Dynamics 6.5 Administration Guide.

Click OK.

22 Click Validate.

Validate shows the result of certain checks that can be run prior to the migration. The Result
column shows the status of the validation checks. If errors are displayed, you can choose to
correct those errors prior to running the migration.
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Cross-Empire Data Migration Wizard - Data and Security E3

© Folder to Folder

Validate Migration
Validation Results

& Select Al €D Select Mone

Source Target Result

& VOESNW\WOL2\Dept Shares\Support  Y\win-2012-r2, cotec, com\MYC\Departments\Support Operation successful,

Validate Cancel

23 (Conditional) Take any necessary action in the Windows network file system target and then re-
run the Data Migration Wizard.

24 Click Migrate.

A page appears with details of the data migration events that are queued for processing. To view
the status of migration events, click Events. For more information on Events, see Pending
Events in the Micro Focus File Dynamics 6.5 Administration Guide.

25 Do one of the following:

+ If you skipped some files to migrate later, click Finish and then continue with “Migrating
Skipped Files” on page 74.

+ If you have migrated all of you data, click Finish.

26 Scan the source server for new of modified directories and files by following the procedures in
Section 1.12.3, “Scanning the Source Server for New or Modified Directories and Files,” on
page 78.
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27 Migrate all new and modified directories and files by following the procedures in Section 1.12.4,
“Migrating the New and Modified Directories and Files,” on page 80.

28 \Verify that all directories and files were migrated by following the procedures in Section 1.12.5,
“Verifying that All Directories and Files were Migrated by Comparing Source Server and Target
Server Contents,” on page 84.
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2.1

2.2

Performing an Active Directory to Active
Directory Cross-Empire Data Migration

¢ Section 2.1, “Overview,” on page 95
+ Section 2.2, “Prerequisite Tasks,” on page 95

¢ Section 2.3, “Perform an Active Directory to Active Directory Cross-Empire Data Migration,” on
page 96

Overview

The Active Directory to Active Directory Cross-Empire Data Migration subsystem enables you to
migrate user and group folders from one Active Directory forest to another, and in the process,
maintain the original permissions, ownership, and disk quota settings.

Of course, you can modify the permissions, ownership, and disk quota settings automatically
following the migration through File Dynamics policies and Management Actions.

IMPORTANT: Because of the potential complexity of an Active Directory to Active Directory Cross-
Empire Data Migration, Micro Focus highly recommends that you utilize the expertise of a Micro
Focus Support representative or a qualified partner.

Prerequisite Tasks

Before you can perform an Active Directory to Active Directory Cross-Empire Data Migration, you
must first perform some prerequisite tasks on the source and target servers, along with establishing a
configured trust relationship between the two.

Create matching user and group objects in the target forest for objects in the source forest.
Make sure you have installed all File Dynamics components in the target forest.

Disable file screening and virus protection software on the target server during the migration.
Configure DNS so that the source and target forest can communicate.

o 0N~

Configure a forest trust between the source and target forest.
At a minimum, a one-way trust is required so that the target forest can access the source forest.

For a detailed explanation of forest trust requirements, see Forest Trusts in the Micro Focus File
Dynamics 6.5 Administration Guide.

6. Fromthe Utilities\ CEDMfolder on the File Dynamics ISO image, copy the
CEDMScanConpar e. exe utility to either the Windows target server or to a Windows server where
you are going to administer the migration.
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2.3 Perform an Active Directory to Active Directory
Cross-Empire Data Migration

+ Section 2.3.1, “Establish a Forest Trust Configuration in the Admin Client,” on page 96

+ Section 2.3.2, “Assign Administrative Rights to the fdproxyrights Group,” on page 96

+ Section 2.3.3, “Assign Permissions to the fdproxyrights Group,” on page 97

+ Section 2.3.4, “Verify that the Admin Client Can See Shares on the Source Server,” on page 98
¢ Section 2.3.5, “Create an Identity Map,” on page 98

+ Section 2.3.6, “Preview the Source Paths for the Migration,” on page 102

+ Section 2.3.7, “Add Unmapped Objects to the Identity Map,” on page 104

+ Section 2.3.8, “Generating a Preview Report Before Migrating,” on page 105

¢ Section 2.3.9, “Determine If You Are Going to Migrate the Data in Two Phases or One,” on
page 105

¢ Section 2.3.10, “Migrate Group Data,” on page 106

¢ Section 2.3.11, “Migrate User Data,” on page 110

¢ Section 2.3.12, “Determine If Any Files Were Skipped,” on page 111

+ Section 2.3.13, “Migrate Skipped, Modified, and New Files,” on page 111

¢ Section 2.3.14, “Using CEDMScanCompare.exe to Compare Folders and Files Between the
Source and Target,” on page 113

+ Section 2.3.15, “Manage the Migrated User Folders through a File Dynamics Home Folder
Policy,” on page 115

2.3.1 Establish a Forest Trust Configuration in the Admin Client

Launch the Admin Client and click the Home tab.

Click Forest Trusts and select the check box next to the displayed source forest.
Click Apply.

Close out of the Admin Client.

Launch the Admin Client and log in.

O g A WON -

From the Home tab, click Forest Trusts and verify that the status for forest trust reads:

Trust is fully configured and usabl e.

23.2 Assign Administrative Rights to the fdproxyrights Group

Follow these procedures to add the fdproxyrights group of the target forest as a member of the local
administrators group on the server or appliance in the source forest.

1 On the source server, launch Active Directory Users and Computers.

2 From the Bui | ti n directory of the forest, double-click Admi ni strat ors.

3 Click the Members tab.

4 Click Add.

This opens the Select Users, Contacts, Computers, Service Accounts, or Groups dialog box.
5 Click Locations.
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This opens the Locations dialog box.
6 Select the target forest and click OK.

7 In the Enter the object names to select field of the Select Users, Contacts, Computers, Service
Accounts, or Groups dialog box, type f dp and click check names.

This opens the Multiple Names Found dialog box.
8 Select f dpr oxyri ght s and click OK.

Select Users, Contacts, Computers, Service Accounts, or Groups >

Select this object type:
|Llsers. Service Accourts, Groups, Built4n securty principals, or Cther |:| Object Types...

From this location:
||:.|1_.rnami|:s.|:cteu:.c:rg | Locations...

Enterthe object names to select (zxamples):
file dynamicsprooeTights| Check Mames

Advanced... QK Cancel

9 Click OK to close the Select Users, Contact, Computers, Service Accounts, or Groups dialog
box.

f dproxyri ght s is added to the list of members in the Administrators dialog box.
10 Click OK to close the Administrators dialog box.

2.3.3 Assign Permissions to the fdproxyrights Group

Follow these procedures to assign the fdproxyrights group of the target server, FULL Share
Permissions to shares that File Dynamics will be migrating from the source forest.

1 Using Windows Explorer on the source server, right-click the shares you plan to migrate and
select Properties.
This opens the Properties dialog box.
2 Click the Sharing tab and click Advanced Sharing.
This opens the Advanced Sharing dialog box.
3 Click Permissions.
This opens the Permissions dialog box.
4 Click Add.
This opens the Select Users, Computers, Service Accounts, or Groups dialog box.
5 Click Locations.
This opens the Locations dialog box.
6 Select the target forest and click OK.

7 In the Enter the object names to select field of the Select Users, Computers, Service Accounts,
or Groups dialog box, type f dpr oxy and click Check names.
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2.3.5

This opens the Multiple Names Found dialog box.
8 Select f dproxyri ghts and click OK.

9 In the Permissions dialog box pertaining to the share you selected previously, assign
fdproxyrights Full Control.

10 Click OK to save the setting and close the Permission dialog box.
11 Repeat these steps for all other shares you plan to migrate.
12 Close the Advanced Sharing and Properties dialog boxes.

Verify that the Admin Client Can See Shares on the Source
Server

Follow these procedures to verify that the Admin Client can see the shares that you plan to migrate.

1 Launch the Admin Client and click the Home tab.

2 Click Storage Resources.

3 Verify that the shares you want to migrate are listed.

4 (Conditional) If the shares are not listed, click Rebuild.

Create an Identity Map

File Dynamics uses an identity map to specify associations between the users and groups of the
source forest with the users and groups of the target forest.

As specified in Section 2.2, “Prerequisite Tasks,” on page 95, you must create the associated target
server users, groups, and shares before you migrate as the Active Directory to Active Directory
Cross-Empire Data Migration subsystem does not create these associated objects on the target
server.

IMPORTANT: If you are creating an identity map of more than 25,000 objects, we recommend 8GB
to 12GB of memory for the workstation or server running the Admin Client.

Launch the Admin Client and click the Cross-Empire Data Migration tab.
Click Active Directory to Active Directory.

Select the source Active Directory forest.

Click Edit Identity Map.

Click Identity Map Entry Wizard.

Select both the User to User and Group to Group check boxes.

N O a0 A WON -

From the Match Attribute drop-down menu, select one of the following options:

SAM-Account-Name: This attribute can be used when you want to populate the identity map
with objects in the source and target forest that have the same corresponding attribute value. By
choosing SAM-Account-Name (SAM) as the Match Attribute, (depending on your Source and
Target Scopes) the engine will search the source and target forests for objects whose SAM are
the same value.

Common-Name: This attribute selection functions in the same manner as the SAM-Account
Name, but for Common-Names (CN).
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Object-SID: This option is only applicable in the case where accounts have been migrated from
the source to the target using a tool such as Active Directory Migration Tool (ADMT). When
ADMT is used, you can opt to copy the Object-Sid. This results in the target object containing the
Object-Sid of the originating source object in the SID-History attribute.

For more information, refer to these Microsoft documents:
+ https://msdn.microsoft.com/en-us/library/ms679833(v=vs.85).aspx
+ https://technet.microsoft.com/en-us/library/cc778824(v=ws.10).aspx

When this Match Attribute is chosen, the engine will enumerate objects in the source and then
search for objects whose SID-History attribute contains the source object's Object-Sid. If objects
have not been migrated such that the source's Object-Sid is in the target's SID-History, you must
use either SAM-Account-Name or Common-Name to populate the identity map.

Well-known SIDS: This option should be used when you want to populate the identity map with
well-known SIDs whose relative identifiers (RIDs) are relative to each domain (e.g.
chroni cl e\ admi ni st rat or ) and whose domain identifier is not "Builtin" (32).

For more information, refer to this Microsoft document: https://msdn.microsoft.com/en-us/library/
windows/desktop/aa379649(v=vs.85).aspx

Builtin well-known SIDs can be added and mapped manually in the Identity Map editor by
selecting an object from the Well-known SIDs tab, right-clicking and selecting Add Identity Map
Entry.
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Identity Map Entry Wizard

|dentity Map Entry Wizard

Select Options for Matching Criteria

Matching Scope

Match Type: | /| User to User

i

Match Attribute: | SAM-Account-Mame  ~

Target Matching Pattern| *

Search Subtree

Source Scope
Search Base: nfms.utopia.novell.com Browse
Search Subtree
Target Scope
Search Base: dynamics.cctec.org Erowse

Cancel

8 Verify that the source forest and target forest in the Source Scope and Target Scope regions

respectively, are correct and click Next.
9 Observe the matching results of source and target groups and users.
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Identity Map Entry Wizard

SOTS SIS SIS IS SIS SIS S

e beteebodedoledodedo o

" Select All

|dentity Map Entry Wizard

Generate ldentity Map

Matching Results

[] Deselect All

Source SAM Account [105)
MFMS\arooney
MFMS\bcagney
MFM5\bstreisand
NFMS\blombardi
MFMS\creeve
MFMS\dstanwyck
NFMS\Fwoolworth
MFMS\geastman
MFMS\jhowe
MNFEMS\ball
NFMSmcombs
MFMS\mlangella

I, = Entry assigned to an existing target

i Rebuild

Target SAM
DYNAMICS\arooney
DYNAMICS\bcagney
DYNAMICS\bstreisand
DYNAMICS\blombardi
DYNAMICS \creeve
DYNAMICS\dstanwyck
DYNAMICS\fwoolwaorth
DYNAMICS\geastman
DYNAMICS \jhowe
DYNAMICS\Iball
DYNAMICS\mcombs
DYNAMICS \mlangella

" = Entry already assigned to the matched target
ﬂ = Entry assigned to the [Do Mot Translate] target

Current Target SAM
[Do Mot Translate]
[Do Mot Translate]
[Do Mot Translate]
[Do Mot Translate]
[Do Mot Translate]
[Do Mot Translate]
[Do Mot Translate]
[Do Mot Translate]
[Do Mot Translate]
[Do Mot Translate]
[Do Mot Translate]
[Do Mot Translate]

v

Source Objects Loaded: 261
Target Objects Loaded: 105

Mext =

Cancel

10 Click Next.

11 In the Import Map Entries page, leave the Auto-save Identity Map updates to Engine check box
selected and click Finish.
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The users and groups on the source and target forests are now matched.

Identity Map

Source Account
& 1A Wellknown SIDs]
& NFMS\acox
& MFMS\ajames
& NFMS\amartin
L NFMs\aman
& MFMS\anance
L HFMsiareid
& NFMS\arooney
&L NFMS\atait
.l.ﬂ- MFMS\Atlanta Employees
& MNFMS\bcagney
2L HEMS\bark

Domain All Domains

sID [All Well-known 5IDs]

f) Identity Map Entry Wizard &‘ Manage Map Entries -

Target Account

[Do Mot Translate]
& DYNAMICS\acox
& DYNAMICS\ajames
& DYNAMICS\amartin
& DYNAMICS\amarx
A D¥NAMICS\anance
& DvNAMICS\areid
& DYNAMICS\aroaney
& DYNAMICS\ataft
.ﬁ’- DYNAMICS\Atlanta Employees
& DYNAMICS\beagney
2. DYNAMICS\belark

105

Tp Source Paths -

o Reload G Refresh
Browse Target Search Target
G Refresh

> /\ dynamics.cetecorg

oK

‘Well-known SIDs

Cancel

Total Entries: 106 Mapped Entries:

2.3.6

Preview the Source Paths for the Migration

Follow these procedures to preview the migration source paths as well as add and match any missing
objects to the identity map.

1 In the Identity Map interface, click Source Paths > Generate Preview Report.

2 In the Preview Migration Source Paths dialog box, in the upper left-hand pane, navigate to the
desired share and double-click it to add it to the Path window to the right.
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Preview Migration Source Paths
P Preview Paths | Path Scan Options: | Scan File Owners - Report Type: | Full Report - emove

Path
- Find Clear
Wmsadutp.nfms.utopia.novell. com\HQShare\Departments

~ /\ nfms.utopia.novell.com -
v fmsadutp.nfms utopia.novell.com
» I AtlantaShare

» : Atlantallsers
« I HOshare

> Common 5hare

» B Courses

Pl Departments

» T3] Engineering

» B3 Finance v
Permission Entries (0} Owner Entries (0] Unique |Ds (0]
Source Account Path Assigned Permissions Target Account Last Error

Add Entries Close

3 From the Path Scan Options drop-down menu, select from the following options:

Scan Folders Only: Scans only the folder permissions in the specified paths.
Scan File Owners: Scans the folder permissions and the file owners in the specified paths.

Scan File Owners and Permissions: Scans the folder permissions, file owners, and file
permissions in the specified paths.

4 Click Preview Paths.
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Preview Migration Source Paths — [m} x
P Preview Paths | Path Scan Options: | Scan File Owners - Report Type: | Full Report -

Path
- Find Clear
Wmsadutp.nfms.utopia.novell. com\HQShare\Departments

~ /\ nfms.utopia.novell.com -
v fmsadutp.nfms utopia.novell.com
» I AtlantaShare

» : Atlantallsers

~ I HOshare
» T Common Share
» B Courses
~ T Departments
» T3] Engineering

» B3 Finance v

Permission Entries [42) Owner Entries (233) Unigue IDs [22)

Source Account Path Assigned Permissions Target Account Last Error
1 &'- MFMS\Finance Dept == “Wmsadutp.nfms.utopia.n., = MELRW o (0} Operation successful, =
1 jgl MFMS\HQ Employees 55 'Wmsadutp.nfms.utopia.n. | ELR e 0} Operation successful,
+ 2k NFMS\HQ Marketing £5 “Wfmsadutp.nfms.utopia.n... = MELRW 2E DYNAMICS\HO Marketing (0} Operation successful.
\f}.‘- MFMS\HO Sales T3 “Fmsadutp.nfms.utopia.n.. = MELRW .l‘- DYNAMICS\HO Sales (0} Operation successful.
1 &'- MFMS\T Administrators =5 “WFmsadutp.nfms.utopia.n.. = MELRW o (0} Operation successful,
V&l MFMS\T Support 55 Wmsadutp.nfms.utopia.n.. | FMELRW "- DYNAMICSYT Support (0} Operation successful,
iV g ﬁ MNFMS\Medical 5 “Wfmsadutp.nfms.utopia.n... | MELRW L{ DYNAMICS\Medical (0} Operation successful.
\f}.‘- MFMS\Training T3 “Fmsadutp.nfms.utopia.n.. = MELRW .l‘- DYNAMICS\Training (0} Operation successful, .
Add Entries Close

A Unmapped Permissions: 36 A Unmapped Owners: 52

For ease in identifying all unmapped (orphaned) SIDs, use the sort arrow which is located on the
first column heading in the lower portion of the interface.

5 Repeat Step 2 for all shares you want to migrate.

6 Click the Owner Entries tab and view the orphaned SIDs, meaning all of the folders and files
without owners.

7 Click the Unique IDs tab and view the unmatched objects.
These are objects that you will need to add to the identity map.
8 Click Add Entries to add the new entries to the identity map.

Click Close to close the Preview Paths page.

23.7 Add Unmapped Objects to the Identity Map

104

Follow these procedures to add any unmapped objects listed in the Unique IDs tab to the identity
map.

1 In the identity map, click the Target Account column heading to sort unmapped objects so they
are all listed as a group at the top of the list.

2 From the Browser Target tab on the right pane, locate an object you want to indicate as an
owner for an unmapped object and drag the object up to the unmapped object’s corresponding
Target Account column entry.
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2.3.8

2.3.9

Identity Map - o x

# \dentity Map Entry Wizard | J Manage Map Entries~ | ©p Source Paths~ 5] Load~ [ Save | (JReload | 55 Refresh
Source Account Target Account Browse Target Search Target | Well-known 5IDs
& [All Well-known SIDs] [Do Mot Translate] “ Name sID
£ BT Administrators & BUILTIN\Administrators 8 Avthentication authority asse... | 5-115-1 o
& HFMS\scox & DINAMICS\acox & BuLTINAccess Control Assist... | 541532579
L NFMS\ajames A Dvnamicsajames 7 | BUILTINVAdministrators
& NFMS\amartin & oraMICs:amartin & suiLTimBackup Operators 5-1-5-32-551
& HFMS\aman &b DINAMICS ama & BULTINCertificate Service DC... | 5-1-5.32-574
& NFHS\anance & oraMICsianance & suinmcyptographic Operat... | 5-1-5-32.569
& NFKSareid & DIHAMICS areid & sULTINDIstributed COM Users | 5-1-5-32-562
& NFMS\arooney & DvaMICSarooney & suiLTivEvent Log Readers 5-1-5.32.573
L HEMSatart &L DiNAMICSataft 2 Ui Guests 1.5.30.548
&l MNFMS\Atlanta Employees ].’- DYNAMICS\Atlanta Employees g BUILTIN\Hyper-V Administrators | 5-1-5-32.578
2L MFMS\Atlanta Engineers 2L DYMAMICS\Atlanta Engineers v 2 BUILTINVIS_IUSRS 5.1.5.32-568
a BUILTIN\Netwark Configurati... | 5-1-5-32-556
FDM BUILTIN\Administrators o FDM BUILTIN\Administrators - 2 BUILTINVPerformance Log Users | 5-1-5-32-359
Type Index (27) Non DS Security Principal Type Index (27) Non DS Security Principal a BUILTIN\Performance Manitor.., | 5-1-5-32-558
Class Name | [Mon-DS Security Principal] Class Name | Mon D5 Security Principal 2 BUILTIN\Power Users 5-1.5.32-547
GuID GUID & suiLTINPrint Operators 5.1-532-550
SAM Acco... | Administrators SAM Acco... | Administrators 2 BUILTIN\RDS Endpoint Servers 51.5.32.576
Domain BUILTIM Domain BUILTIN
<0 153250 <D s153251 a BUILTIN\RDS Management Ser... | 5-1-5-32-577
Last Status (0} Operation successful, v Last Status (0} Operation successful, v 2 BUILTINRDS Remote Access 5. | 5-1-332-573 T
0K Cancel Apply

Total Entries: 144 Mapped Entries: 124

This changes the unmapped object’s Target Account listing from [ Do Not Transl at e] to the
new owner object.

3 When you are finished specifying owners for your unmapped objects, click Apply.
4 Click OK.

Generating a Preview Report Before Migrating

You can easily generate a preview report as a CSV file before you migrate. This might be useful if you
needed to provide a report to a ClO or other members of the migration team.

1 Launch the Admin Client and click the Cross-Empire Data Migration tab.

2 Click Preview Source Path.

3 Double-click the top entry in the list.

4 From the View Report page, click the CSV icon to save the report as a CSV file.

Determine If You Are Going to Migrate the Data in Two
Phases or One

Before you migrate data from the source to the target forest, you must determine if you will be
migrating in two phases or one.

Two-Phase Migration

In the first phase, you migrate all unopened files while skipping all opened files. In the second phase,
you get all of your users to log off of the network (assuring that they have no files opened), then you
migrate all of the skipped files, then all of the new and modified files.

A two-phased migration is more suitable to organizations with data sets too large to migrate over a
weekend.
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Single-Phase Migration

This approach lets you migrate all of the data in one phase. You must have all users logged off of the
network and be able to migrate the data before the users return to work.

2.3.10 Migrate Group Data

TIP: To view the status of the migration, we recommend that you install and run a Tail program and
use it to tail the Agent log path located at: " %pr ogr andat a% M cro Focus\Fil e
Dynami cs\ Agent \ | og\ f sagent - xxx- xxx. | og”

Follow these procedures to migrate group data from the source forest to the target forest.

1 In the Admin Client, click the Cross-Empire Data Migration tab.
2 Click Active Directory to Active Directory.
3 Select Migration Wizards > Data and Security.

This launches the Folder to Folder Migration wizard.

Cross-Empire Data Migration Wizard - Data and Security

Folder to Folder Migration

Select Migration Type Options

Migration Type Options

Migration Type: | Folder to Folder -

Automatic Mappings
Generate Automatic Mappings

Browse

Browse

Mext =
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4 Do one of the following:

+ If you plan to do a two-phase migration by skipping open files, leave the Generate
Automatic Mappings check box deselected and click Next. Browse to specify the source
and target folders and click Next.

This method will create a single source path and single target path, which alleviates
potential problems that can surface when skipping open files during a migration.

+ If you plan to do a single-phase migration, you can select the Generate Automatic
Mappings check box to create any needed subfolders on the target that do not already
exist. Browse to specify the source and target folders and click Next.

5 In the Define Mappings page of the wizard, observe the migration events that are now queued
up.

Cross-Empire Data Migration Wizard - Data and Security

Folder to Folder Migration

Define Mappings

ok Add " Edit == Remove Select~ [ Deselect~ = 3E]Load [ Save

Source Folder Target Folder

| & ‘Wmsadutp.nfms.utopia.novell. com\NYCSha...  ‘idynamics.cctec.org\DFS\NYCWNYCShare\Departments

= Matching target path found

Auto Map Count: 0 Total: 1 Selected: 1

Mext =

6 Click Next.

7 (Conditional) If you are doing a two-phase migration, in the Data Copy Options page, select the
Skip Open Files check box.

7a Click the Browse button that corresponds to the Delta File field and through the path
browser, select the folder where you want to store the delta file.

7b Right-click and select New Folder and click OK.
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The delta file name is created and displayed in the Delta File field.

Cross-Empire Data Migration Wizard - Data and Security m} x

Folder to Folder Migration

Data Copy Options

Overwrite Options

Mever Overwrite i
Directory Quota

Do Mot Apply Source Directory Quota w

Target Subfolder

Use Subfolder

Open File Options

Delta File: | tments\IT Deptimigration Skipped Files\nfms. utopia.novell.com-132110510466535446-delta.txt Browse

8 Click Next.
9 In the Data and Security page, select the Use the Identity Map check box.
10 Select either the Merge Security or Overwrite Security option.

Merge Security: This option merges the permissions of the source folder with those of the target
folder.

Overwrite Security: This option overwrites the permissions of the target folder with those of the
source folder.
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11 From the Owner for Target Folder drop-down menu, select your preferred option.

11a If you select either Default Owner if not in Identity Map or Set Explicit Owner, browse to
assign an owner.

12 From the Owner for Target Folder Contents drop-down menu, select your preferred option.

12a If you select either Default Owner if not in Identity Map or Set Explicit Owner, browse to
assign an owner.

Cross-Empire Data Migration Wizard - Data and Security O X

Folder to Folder Migration

Security and Ownership

Identity Map

p @@ 1dentity Map Entry Count: 144 Identity Map

Target Security

® | Merge Security
Owerwrite Security

Ownership

Owner for Target Folder

Copy Existing Source Owner v Browse

Owner for Target Folder Contents

Copy Existing Source Owner ~ Browse

Mext = Cancel

13 Click Next.
14 Click Migrate.
The queued migration events are listed.
15 Click Finish.
16 In the Admin Client, from the Identity Driven tab, click Events to view the status of the migration.

17 (Optional) If you have a Tail program, you can view the status of the migration.
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2311 Migrate User Data

Use these procedures to migrate user home folders from the source forest to the target forest.

1 In the Admin Client, click the Cross-Empire Data Migration tab.
2 Click Active Directory to Active Directory.
3 Select Migration Wizards > Data and Security.

This launches the Folder to Folder Migration wizard.

Cross-Empire Data Migration Wizard - Data and Security O

Folder to Folder Migration

Select Migration Type Options

Migration Type Options

Migration Type: | Folder to Folder -

Automatic Mappings
Generate Automatic Mappings

Browse
Target Folde Browse

Mext =

4 Do one of the following:

+ If you plan to do a two-phase migration by skipping open files, leave the Generate
Automatic Mappings check box deselected and click Next. Browse to specify the source
and target folders and click Next.

This method will create a single source path and single target path, which alleviates
potential problems that can surface when skipping open files during a migration.

+ If you plan to do a single-phase migration, you can select the Generate Automatic
Mappings check box to create any needed subfolders on the target that do not already
exist. Browse to specify the source and target folders and click Next.
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2.3.12

2.3.13

In the Define Mappings page of the wizard, observe the migration events that are now queued
up.
Click Next.

7 Select the appropriate Overwrite and Directory Quota options, and whether the migrated user

data will be located in a subfolder of the target, then click Next.

8 In the Security and Ownership page, select the Use the Identity Map check box.

9 Select either the Merge Security or Overwrite Security option.

10

1"
12
13

14

15

16

17
18

Within the Owner for Target Folder and Owner for Target Contents drop-down menus, leave the
Copy Existing Source Owner options selected.

As a best practice, each user should be established as the owner of their files and folders. For
those instances where folders and files that aren’t owned by the users, we will address them
later once we create a policy and then perform Management Actions following the migration.

Click Next.

In the Copy Filter page, select the User Copy Filter check box.

Click Add to create a copy filter of those files you do not want to copy to the target forest.

For example, you probably want to avoid copying . TMP files.

Click Validate and observe what will be migrated.

If you observe any potential problems, you will want to correct them at this time.

Click Migrate.

The queued migration events are listed.

Click Finish.

In the Admin Client, from the Identity Driven tab, click Events to view the status of the migration.

(Optional) If you have a Tail program, you can view the status of the migration.

Determine If Any Files Were Skipped

Follow these procedures to see if the Delta file lists any skipped files.

1

2

From the location where you saved the Delta file, open it to see if any files are listed.
If any are listed, those are all of the files that were skipped during the first phase of the migration.

(Conditional) If files are listed, you must have the owners of these files close the files before
proceeding with Section 2.3.13, “Migrate Skipped, Modified, and New Files,” on page 111

Migrate Skipped, Modified, and New Files

Follow these procedures to migrate any files that were skipped, modified or that were created since
the first phase of the migration.

1
2
3
4
5

In the Admin Client, click the Cross-Empire Data Migration tab.
Click Active Directory to Active Directory.

Select Migration Wizards > Data and Security.

In the Select Migration Type Options page, click Next.

In the Define Mappings page, specify the same source and target paths that you specified in
Section 2.3.11, “Migrate User Data,” on page 110 and click Next.
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6 In the Data Copy Options page, from the Overwrite Options drop-down menu, select Overwrite
if Newer, select the Skip Open Files check box, and browse to the location where you stored
your original Delta file to create a new Delta file.

Cross-Empire Data Migration Wizard - Data and Security m} x

Folder to Folder Migration

Data Copy Options

Ovenwrite Options

Mever Overwrite v

Directory Quota

Do Mot Apply Source Directory Quota w

Target Subfolder

Use Subfolder

Open File Options

+ | Skip Open Files

Delta File: | tments\T Dept\migration Skipped Files\nfms.utopia.novell.com-132110514248751639-delta.txt Browse

7 Click Next.

8 In the Security and Ownership page, select the Use Identity Map check box, and specify the
same Owner for Target Folder, Owner for Target Folder Contents, and related paths as you did
in Section 2.3.11, “Migrate User Data,” on page 110.

9 Click Next.
10 Click Validate and observe what will be migrated.
If you observe any potential problems, you will want to correct them at this time.
11 Click Migrate.
The queued migration events are listed.
12 Click Finish.
13 In the Admin Client, from the Identity Driven tab, click Events to view the status of the migration.
1

>

(Optional) If you have a Tail program, you can view the status of the migration.
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2.3.14

Files Between the Source and Target

With the skipped, modified, and new files and folders migrated, you are now ready to compare the
folders and files between the source and target forests to verify that everything migrated properly.

1 Launch the CEDMScanCompare utility that you copied earlier.

The following message appears:

Using CEDMScanCompare.exe to Compare Folders and

Info

scan and comparison data.

To begin, click OK to specify a working directory for this utility to use for writing

OK

2 Click OK.

3 Browse to a folder where you want to store the comparison data and click Select Folder.

The CEDMScanCompare utility interface is launched.

File System Scan and Compare

File Help

File Dynamics

Source

Path to Scan: ‘
Filter
/| Indude ol Files and Folders regardiess of age

v Indude files located in root directory

Control

Threads ~ Operation

‘Warking Directory

1~

Output File System Date | [C:\Users\Administrator. NFVS \Documents =

Targel

Path to Scan:
Filter

| Indlude al Fies and Folders regardless of age

Root Subdirectory Name Scan Filter
Indude || Al || Lst || Uncheck Indude v [ Al Unchedk
Directory Name Directory Name

Scan Cutput File Scan Output File

FileName: [FS-scan-output.txt FileName: [FS-scan-output.txt
Compare / Analyze
Output Format Reslits

Cross-Empire Data Maration-<Dir ~ Source Record Counts l:l Only on Target: |:|

Cammen Path Start Points Compare Target Record Count: l:l Only on Source: I:l

targetmissing. bet

Target: I:l Mewer on Target: l:l Open Full Differences Fie

/| Indude files located in root directory

Root Subdirectory Name Scan Filter

The selected folder location is specified in the Working Directory field.

4 In the Source region, for the Path to Scan field, browse to specify the UNC path to the folder in
the source forest you want to scan.
For example: \\ W N- 2012- AlFor est B. ORG NYCvol 1\ Dept Shar es
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5 In the Target region, for the Path to Scan field, browse to specify the UNC path to the folder in
the target forest you want to scan.

For example: \\ W N- 2012- R2. CCTEC. COM NYC\ Depar t ment s

In the Source region, click Scan.

In the Scan Result region, note the findings in the Folders and Files fields.
In the Target region, click Scan.

In the Scan Result region, note the findings in the Folders and Files fields.

o ©W 00 N o

In the Compare / Analyze region, from the FileName drop-down menu, select Cross-Empire Data
Migration-AD.

11 Click Compare.

File System Scan and Compare E
File Help
Control
. . Thresds  Operation Working Directory
File Dynamics
1 v] [outputriesystenpats v]| [ciiusers) NFMS\Documents | [
Source Target
Path to Scan: | g Limigration.org \Employees | = Path to Scan: | Wmsadutp.nfims.utopis. novelcom|MadridUsers | =
Fiter Filter
/| Indude ol Fies and Folders regardiess of age /| Indude fles located in root drectory V| Indude all Fikes and Folders regardiess of age | Inchude files located in root directory
Root Subdrectory Name Scan Filter Root Subdirectory Name Scan Fiter
Al | [ tist || uncheck Al | [ tist || unchek
Directory Name Directory Name
Scan Result Scan Resuit
Scan Output File can Resd Scan Output File can Resul
FileName: |Scan-mig 1. migration org Employees — FileName: [Scan-fmsadutp.nfins utopia.novell{ e
Compare / Analyze
Output Format Results
Common Path Start Points Target Record Count: I:l Only on Source: l:l ’—m|
\
Source: |\mig1.migration.org\Employ Match File Count: I:l Newer on Source: h
Target: [{|fmsadutp.nfins.utopia.novell.c NeweronTercet: || Open Full Differences Fie
dearing up internal tables. . fie ree
deaning up internal tables. . dir tree
deanup complete.
Scan Complete.

12 Do one of the following:

+ If the results show no discrepancies between the source and target, all of the folders and
files were migrated. Proceed with Section 2.3.15, “Manage the Migrated User Folders
through a File Dynamics Home Folder Policy,” on page 115.

+ If the results show discrepancies between the source and target, follow the remaining
procedures in this section.

13 Click Open Full Differences File.
A spreadsheet appears listing:

+ Allfiles on the source that are newer than the same named files on the target, along with the
source and target path of each file.

+ All files on the source that are missing from the target.

14 View the files that are newer on the source server as well as those files on the source server that
were not migrated.
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15 Have all of your network users close any open files in the source area, and once again, follow
the procedures in Section 2.3.13, “Migrate Skipped, Modified, and New Files,” on page 111.

16 Run the CEDMScanCompare utility again. When the you have verified that all of the folders and
files have migrated, proceed with Section 2.3.15, “Manage the Migrated User Folders through a
File Dynamics Home Folder Policy,” on page 115.

Manage the Migrated User Folders through a File Dynamics
Home Folder Policy

Once you have migrated all of the user data, you will want to manage it through File Dynamics.
Follow these procedures to create a Home Folder policy and then enforce the policies settings
through Management Actions.

Prerequisite

If the container where you migrated the user home folders does not already have a File Dynamics
policy, create a Home Folder policy by following the procedures in Creating a User Home Folder
Policy in the Micro Focus File Dynamics 6.5 Administration Guide.

Enforcing the Policy through Management Actions

Perform the following tasks and Management Actions to enforce the policy settings on the migrated
home folders.
1 Run a Consistency Check.

For more information, see Performing a Consistency Check in the Micro Focus File Dynamics
6.5 Administration Guide.

2 Perform the following Management Actions:
+ Assign Managed Path
See Assign Managed Path in the Micro Focus File Dynamics 6.5 Administration Guide.
+ Manage
See Manage in the Micro Focus File Dynamics 6.5 Administration Guide.
+ Apply Permissions
See Apply Permissions in the Micro Focus File Dynamics 6.5 Administration Guide.
+ Apply Owner
See Apply Owner in the Micro Focus File Dynamics 6.5 Administration Guide.
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https://www.novell.com/documentation/file-dynamics-6/pdfdoc/file-dynamics-6_5_admin/file-dynamics-6_5_admin.pdf#bqv2y16
https://www.novell.com/documentation/file-dynamics-6/pdfdoc/file-dynamics-6_5_admin/file-dynamics-6_5_admin.pdf#bqv2y16
https://www.novell.com/documentation/file-dynamics-6/pdfdoc/file-dynamics-6_5_admin/file-dynamics-6_5_admin.pdf#bquzl09
https://www.novell.com/documentation/file-dynamics-6/pdfdoc/file-dynamics-6_5_admin/file-dynamics-6_5_admin.pdf#bqykg4j
https://www.novell.com/documentation/file-dynamics-6/pdfdoc/file-dynamics-6_5_admin/file-dynamics-6_5_admin.pdf#br6t4jx
https://www.novell.com/documentation/file-dynamics-6/pdfdoc/file-dynamics-6_5_admin/file-dynamics-6_5_admin.pdf#bqyk394
https://www.novell.com/documentation/file-dynamics-6/pdfdoc/file-dynamics-6_5_admin/file-dynamics-6_5_admin.pdf#b17jawud
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